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Regulatory Compliance

Thermo Fisher Scientific performs complete testing and evaluation of its products to ensure full compliance with 
applicable domestic and international regulations. When the system is delivered to you, it meets all pertinent 
electromagnetic compatibility (EMC) and safety standards as described below.

Changes that you make to your system might void compliance with one or more of these EMC and safety standards. 
Changes to your system include replacing a part or adding components, options, or peripherals not specifically 
authorized and qualified by Thermo Fisher Scientific. To ensure continued compliance with EMC and safety standards, 
replacement parts and additional components, options, and peripherals must be ordered from Thermo Fisher Scientific 
or one of its authorized representatives.

TSQ Quantum Access MAX

EMC Directive 2004/108/EEC

EMC compliance has been evaluated by TUV Rheinland of North America, Inc.

Low Voltage Safety Compliance

This device complies with European Union Directive 2006/95/EC implemented by 61010-1: 2001.

• TSQ Quantum Access MAX

• TSQ Quantum Ultra

• TSQ Vantage

• TSQ Quantum Access

EN 55011: 2007, A2: 2007 EN 61000-4-4: 2004

EN 61000-3-2: 2006 EN 61000-4-5: 2005

EN 61000-3-3: 1995, A1: 2001, A2: 2005 EN 61000-4-6: 2007

EN 61000-4-2: 1995, A1: 1999, A2: 2001 EN 61000-4-11: 2004

EN 61000-4-3: 2006 EN 61326-1: 2006

FCC Class A: CFR 47 Part 15: 2007



TSQ Quantum Ultra

EMC Directive 89/336/EEC as amended by 92/31/EEC and 93/68/EEC

EMC compliance has been evaluated by Underwriters Laboratories Inc.

Low Voltage Safety Compliance

This device complies with Low Voltage Directive 73/23/EEC and harmonized standard EN 61010-1: 2001.

TSQ Vantage

EMC Directive 2004/108/EC

EMC compliance has been evaluated by TUV Rheinland of North America, Inc.

Low Voltage Safety Compliance

This device complies with the Low Voltage Directive 2006/95/EC and harmonized standard EN 61010-1.

EN 55011: 1998 EN 61000-4-4: 1995, A1: 2001, A2: 2001

EN 61000-3-2: 1995, A1: 1998, A2: 1998, A14: 2000 EN 61000-4-5: 1995, A1: 2001

EN 61000-3-3: 1998 EN 61000-4-6: 2001

EN 61000-4-2: 2000 EN 61000-4-11: 1994, A1: 2001

EN 61000-4-3: 2002 EN 61326-1: 1998

FCC Class A, CFR 47 Part 15: 2005 CISPR 11: 1999, A1: 1999, A2: 2002

EN 55011: 1998, A1: 1999, A2: 2002 EN 61000-4-4: 2004

EN 61000-3-2: 2006 EN 61000-4-5: 2006

EN 61000-3-3: 1995, A1: 2001, A2: 2005 EN 61000-4-6: 2001

EN 61000-4-2: 2001 EN 61000-4-11: 2004

EN 61000-4-3: 2006 EN 61326-1: 2006

FCC Class A, CFR 47 Part 15: 2007 CISPR 11: 1999, A1: 1999, A2: 2002



TSQ Quantum Access

EMC Directive 89/336/EEC, 92/31/EEC, 93/68/EEC

EMC compliance has been evaluated by TUV Rheinland of North America, Inc.

Low Voltage Safety Compliance

This device complies with the Low Voltage Directive EN 61010-1:2001 and harmonized standard EN 61010-1: 2001.

FCC Compliance Statement

Notice on Lifting and Handling of
Thermo Scientific Instruments

For your safety, and in compliance with international regulations, the physical handling of this Thermo Fisher Scientific 
instrument requires a team effort to lift and/or move the instrument. This instrument is too heavy and/or bulky for 
one person alone to handle safely.

EN 55011: 1998, A1: 1999, A2: 2002 EN 61000-4-4: 1995, A1: 2000, A2: 2001

EN 61000-3-2: 2000 EN 61000-4-5: 2001

EN 61000-3-3: 1995, A1: 2001 EN 61000-4-6: 2003

EN 61000-4-2: 2001 EN 61000-4-11: 2001

EN 61000-4-3: 2002 EN 61326: 1997, A1: 1998, A2: 2001, A3: 2003

FCC Class A, CFR 47 Part 15: 2005 CISPR 11: 1999, A1: 1999, A2: 2002

THIS DEVICE COMPLIES WITH PART 15 OF THE FCC RULES. OPERATION IS SUBJECT TO 
THE FOLLOWING TWO CONDITIONS: (1) THIS DEVICE MAY NOT CAUSE HARMFUL 
INTERFERENCE, AND (2) THIS DEVICE MUST ACCEPT ANY INTERFERENCE RECEIVED, 
INCLUDING INTERFERENCE THAT MAY CAUSE UNDESIRED OPERATION.

CAUTION  Read and understand the various precautionary notes, signs, and symbols contained 
inside this manual pertaining to the safe use and operation of this product before using the device. 



Notice on the Proper Use of
Thermo Scientific Instruments

In compliance with international regulations: Use of this instrument in a manner not specified by Thermo Fisher 
Scientific could impair any protection provided by the instrument.

Notice on the Susceptibility 
to Electromagnetic Transmissions

Your instrument is designed to work in a controlled electromagnetic environment. Do not use radio frequency 
transmitters, such as mobile phones, in close proximity to the instrument.

For manufacturing location, see the label on the instrument.



WEEE Compliance

This product is required to comply with the European Union’s Waste Electrical & Electronic Equipment (WEEE) 
Directive 2002/96/EC. It is marked with the following symbol:

Thermo Fisher Scientific has contracted with one or more recycling or disposal companies in each European Union 
(EU) Member State, and these companies should dispose of or recycle this product. See www.thermo.com/
WEEERoHS for further information on Thermo Fisher Scientific’s compliance with these Directives and the 
recyclers in your country.

WEEE Konformität

Dieses Produkt muss die EU Waste Electrical & Electronic Equipment (WEEE) Richtlinie 2002/96/EC erfüllen.  
Das Produkt ist durch folgendes Symbol gekennzeichnet:

Thermo Fisher Scientific hat Vereinbarungen mit Verwertungs-/Entsorgungsfirmen in allen EU-Mitgliedsstaaten 
getroffen, damit dieses Produkt durch diese Firmen wiederverwertet oder entsorgt werden kann. Mehr Information 
über die Einhaltung dieser Anweisungen durch Thermo Fisher Scientific, über die Verwerter, und weitere Hinweise, 
die nützlich sind, um die Produkte zu identifizieren, die unter diese RoHS Anweisung fallen, finden sie unter  
www.thermo.com/WEEERoHS. 

http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS


Conformité DEEE

Ce produit doit être conforme à la directive européenne (2002/96/EC) des  Déchets d'Equipements Electriques et 
Electroniques (DEEE). Il est marqué par le symbole suivant:

Thermo Fisher Scientific s'est associé avec une ou plusieurs compagnies de recyclage dans chaque état membre de 
l’union européenne et ce produit devrait être collecté ou recyclé par celles-ci. Davantage d'informations sur la 
conformité de Thermo Fisher Scientific à ces directives, les recycleurs dans votre pays et les informations sur les 
produits Thermo Fisher Scientific qui peuvent aider la détection des substances sujettes à la directive RoHS sont 
disponibles sur www.thermo.com/WEEERoHS. 

http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS
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Shock da folgorazione. L’apparecchio è 
alimentato da corrente ad alta tensione 
che puo provocare lesioni fisiche. Prima di 
effettuare qualsiasi intervento di 
manutenzione occorre spegnere ed isolare 
l’apparecchio dalla linea elettrica. Non 
attivare lo strumento senza lo schermo 
superiore. Non togliere i coperchi a 
protezione dalle schede di circuito 
stampato (PCB).

e contener 
. Utilice 
quimicos 
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cipientes y 
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Prodotti chimici. Possibile presenza di 
sostanze chimiche pericolose 
nell’apparecchio. Indossare dei guanti per 
maneggiare prodotti chimici tossici, 
cancerogeni, mutageni, o 
corrosivi/irritanti. Utilizzare contenitori 
aprovo e seguire la procedura indicata per 
lo smaltimento dei residui di olio.

 que lop 
de efectuar 

Calore. Attendere che i componenti 
riscaldati si raffreddino prima di 
effetturare l’intervento di manutenzione.

ar el 
 

Incendio. Adottare le dovute precauzioni 
quando si usa il sistema in presenza di gas 
infiammabili.

icaduras de 
s que 
usar 
teojos 
tos 
 
.

Pericolo per la vista. Gli schizzi di 
prodotti chimici o delle particelle presenti 
nell’aria potrebbero causare danni alla 
vista. Indossare occhiali protettivi quando 
si maneggiano prodotti chimici o si 
effettuano interventi di manutenzione 
sull’apparecchio.

e existe un 
gorias 
én se utiliza 
l usuario a 
n este 

Pericolo generico. Pericolo non 
compreso tra le precedenti categorie. 
Questo simbolo è utilizzato inoltre 
sull’apparecchio per segnalare all’utente 
di consultare le istruzioni descritte nel 
presente manuale.

de un 
tes de 
o con la 
local para 
r Scientific 

Quando e in dubbio la misura di sicurezza 
per una procedura, prima di continuare, si 
prega di mettersi in contatto con il 
Servizio di Assistenza Tecnica locale per i 
prodotti di Thermo Fisher Scientific San 
Jose.
CAUTION Symbol CAUTION VORSICHT ATTENTION PRECAUCION

Electric Shock: This instrument uses 
high voltages that can cause personal 
injury. Before servicing, shut down the 
instrument and disconnect the instrument 
from line power. Keep the top cover on 
while operating the instrument. Do not 
remove protective covers from PCBs.

Elektroschock: In diesem Gerät werden 
Hochspannungen verwendet, die 
Verletzungen verursachen können. Vor 
Wartungsarbeiten muß das Gerät 
abgeschaltet und vom Netz getrennt 
werden. Betreiben Sie Wartungsarbeiten 
nicht mit abgenommenem Deckel. Nehmen 
Sie die Schutzabdeckung von Leiterplatten 
nicht ab.

Choc électrique: L’instrument utilise des 
tensions capables d’infliger des blessures 
corprelles. L’instrument doit être arrêté et 
débranché de la source de courant avant 
tout intervention. Ne pas utiliser 
l’instrument sans son couvercle. Ne pas 
elensver les étuis protecteurs des cartes de 
circuits imprimés.

Descarga eléctrica: Este ins
utiliza altas tensiones, capace
producir lesiones personales. A
dar servicio de mantenimiento
instrumento, éste debera apag
desconectarse de la línea de a
eléctrica. No opere el instrume
cubiertas exteriores quitadas. N
las cubiertas protectoras de la
de circuito impreso.

Chemical: This instrument might contain 
hazardous chemicals. Wear gloves when 
handling toxic, carcinogenic, mutagenic, 
or corrosive or irritant chemicals. Use 
approved containers and proper 
procedures to dispose waste oil.

Chemikalien: Dieses Gerät kann 
gefährliche Chemikalien enthalten. Tragen 
Sie Schutzhandschuhe beim Umgang mit 
toxischen, karzinogenen, mutagenen oder 
ätzenden/reizenden Chemikalien. 
Entsorgen Sie verbrauchtes Öl 
entsprechend den Vorschriften in den 
vorgeschriebenen Behältern.

Chimique: Des produits chemiques 
dangereux peuven se trouver dans 
l’instrument. Proted dos gants pour 
manipuler tous produits chemiques 
toxiques, cancérigènes, mutagènes, ou 
corrosifs/irritants. Utiliser des récipients 
et des procédures homologuées pour se 
débarrasser des déchets d’huile.

Química: El instrumento pued
productos quimicos peligrosos
guantes al manejar productos 
tóxicos, carcinogenos, mutage
corrosivos/irritantes. Utilice re
procedimientos aprobados par
deshacerse del aceite usado.

Heat: Before servicing the instrument, 
allow any heated components to cool.

Hitze: Warten Sie erhitzte Komponenten 
erst nachdem diese sich abgekühlt haben.

Haute Temperature: Permettre aux 
composants chauffés de refroidir avant 
tout intervention.

Altas temperaturas: Permita
componentes se enfríen, ante 
servicio de mantenimiento.

Fire: Use care when operating the system 
in the presence of flammable gases.

Feuer: Beachten Sie die einschlägigen 
VorsichtsmaBnahmen, wenn Sie das 
System in Gegenwart von entzündbaren 
Gasen betreiben.

Incendie: Agir avec précaution lors de 
l’utilisation du système en présence de 
gaz inflammables.

Fuego: Tenga cuidado al oper
sistema en presencia de gases
inflamables.

Eye Hazard: Eye damage could occur 
from splattered chemicals or flying 
particles. Wear safety glasses when 
handling chemicals or servicing the 
instrument.

Verletzungsgefahr der Augen: 
Verspritzte Chemikalien oder kleine 
Partikel können Augenverletzungen 
verursachen. Tragen Sie beim Umgang mit 
Chemikalien oder bei der Wartung des 
Gerätes eine Schutzbrille.

Danger pour les yeux: Dex projections 
chimiques, liquides, ou solides peuvent 
être dangereuses pour les yeux. Porter des 
lunettes de protection lors de toute 
manipulationde produit chimique ou pour 
toute intervention sur l’instrument.

Peligro par los ojos: Las sal
productos químicos o particula
salten bruscamente pueden ca
lesiones en los ojos. Utilice an
protectores al mnipular produc
químicos o al darle servicio de
mantenimiento al instrumento

General Hazard: A hazard is present that 
is not included in the above categories. 
Also, this symbol appears on the 
instrument to refer the user to instructions 
in this manual.

Allgemeine Gefahr: Es besteht eine 
weitere Gefahr, die nicht in den 
vorstehenden Kategorien beschrieben ist. 
Dieses Symbol wird im Handbuch 
auBerdem dazu verwendet, um den 
Benutzer auf Anweisungen hinzuweisen.

Danger général: Indique la présence 
d;un risque n’appartenant pas aux 
catégories citées plus haut. Ce symbole 
figure également sur l’instrument pour 
renvoyer l’utilisateur aux instructions du 
présent manuel.

Peligro general: Significa qu
peligro no incluido en las cate
anteriores. Este simbolo tambi
en el instrumento par referir a
las instrucciones contenidas e
manual.

When the safety of a procedure is 
questionable, contact your local Technical 
Support organization for Thermo Fisher 
Scientific San Jose Products.

Wenn Sie sich über die Sicherheit eines 
Verfahrens im unklaren sind, setzen Sie 
sich, bevor Sie fortfahren, mit Ihrer 
lokalen technischen 
Unterstützungsorganisation für Thermo 
Fisher Scientific San Jose Produkte in 
Verbindung.

Si la sûreté d’un procédure est incertaine, 
avant de continuer, contacter le plus 
proche Service Clientèle pour les produits 
de Thermo Fisher Scientific San Jose.

Cuando la certidumbre acerca 
procedimiento sea dudosa, an
proseguir, pongase en contact
Oficina de Asistencia Tecnica 
los productos de Thermo Fishe
San Jose.



CAUTION Symbol CAUTION

Electric Shock: This instrument uses 
high voltages that can cause personal 
injury. Before servicing, shut down the 
instrument and disconnect the instrument 
from line power. Keep the top cover on 
while operating the instrument. Do not 
remove protective covers from PCBs.

Chemical: This instrument might contain 
hazardous chemicals. Wear gloves when 
handling toxic, carcinogenic, mutagenic, 
or corrosive or irritant chemicals. Use 
approved containers and proper 
procedures to dispose waste oil.

Heat: Before servicing the instrument, 
allow any heated components to cool.

Fire: Use care when operating the system 
in the presence of flammable gases.

Eye Hazard: Eye damage could occur 
from splattered chemicals or flying 
particles. Wear safety glasses when 
handling chemicals or servicing the 
instrument.

General Hazard: A hazard is present that 
is not included in the above categories. 
Also, this symbol appears on the 
instrument to refer the user to instructions 
in this manual.

When the safety of a procedure is 
questionable, contact your local Technical 
Support organization for Thermo Fisher 
Scientific San Jose Products.
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Preface

About This Guide
This TSQ Series Hardware Manual contains a description of the modes of operation and 
principle hardware components of your TSQ system. In addition, this manual provides 
step-by-step instructions for cleaning and maintaining your mass spectrometer.

Related Documentation
In addition to this manual, Thermo Fisher Scientific provides the following for TSQ Series 
mass spectrometers:

• Preinstallation Requirements Guide 

• Getting Connected Guide

• Getting Started Guide

• H-ESI Probe User Guide

• HESI-II Probe User Guide

• Ion Max and Ion Max-S API Source Hardware Manual

• Help available from within the software

Safety and Special Notices
Make sure you follow the precautionary statements presented in this guide. The safety and 
other special notices appear in boxes.

Safety and special notices include the following:

CAUTION  Highlights hazards to humans, property, or the environment. Each CAUTION 
notice is accompanied by an appropriate CAUTION symbol. 

IMPORTANT  Highlights information necessary to prevent damage to software, loss of 
data, or invalid test results; or might contain information that is critical for optimal 
performance of the system.
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Safety Precautions
Observe the following safety precautions when you operate or perform service on the mass 
spectrometer.

Note  Highlights information of general interest.

Tip  Highlights helpful information that can make a task easier.

CAUTION  Do Not Perform Any Servicing Other Than That Contained in the TSQ 
Series Hardware Manual. To avoid personal injury or damage to the instrument, do not 
perform any servicing other than that contained in the TSQ Series Hardware Manual or 
related manuals unless you are authorized to do so.

CAUTION  Shut Down the Mass Spectrometer and Disconnect It From Line Power 
Before You Service It. High voltages capable of causing personal injury are used in the 
instrument. Some maintenance procedures require that the mass spectrometer be shut 
down and disconnected from line power before service is performed. Do not operate the 
mass spectrometer with the top or side covers off. Do not remove protective covers from 
PCBs.

CAUTION  Respect Heated Zones. Treat heated zones with respect. The ion transfer 
capillary, the H-ESI vaporizer, and the APCI vaporizer might be very hot and might cause 
severe burns if they are touched. Allow heated components to cool before you service 
them.

CAUTION  Place the Mass Spectrometer in Standby (or Off ) Before You Open the 
Atmospheric Pressure Ionization (API) Source. The presence of atmospheric oxygen in 
the API source when the mass spectrometer is On could be unsafe. (The TSQ 
automatically turns the mass spectrometer Off when you open the API source; however, it 
is best to take this added precaution.)

CAUTION  Provide and Adequate Fume Exhaust System. It is your responsibility to 
provide an adequate fume exhaust system. Samples and solvents that are introduced into 
the TSQ mass spectrometer will eventually be exhausted from the forepump. Therefore, 
the forepump should be connected to a fume exhaust system. Consult local regulations for 
the proper method of exhausting the fumes from your system.
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Solvent and Gas Purity Requirements
Use the highest purity solvents available. The TSQ mass spectrometer is extremely sensitive to 
solvent impurities. Some solvent impurities are transparent to UV/Visible detectors, but are 
easily detected by the TSQ mass spectrometer. Liquid chromatography grade is the minimum 
acceptable purity. Higher grade solvents are preferred. Distilled water is recommended. 
Deionized water contains chemicals and is not recommended. 

The following is a list of international sources that can supply high quality solvents: 

The TSQ mass spectrometer uses argon as a collision gas. The argon must be high purity 
(99.995%). The required gas pressure is 135 ± 70 kPa (20 ± 10 psig). Thermo Fisher 
Scientific has found that particulate filters are often contaminated and are therefore not 
recommended.

Service Philosophy
Servicing the TSQ system consists of performing procedures required to maintain system 
performance standards, prevent system failure, restore the system to an operating condition, 
or all of the above. Routine and preventive maintenance procedures are documented in this 
manual.

The user is responsible for routine and preventive maintenance during and after the warranty 
period. Regular maintenance increases the life of the system, maximizes the up-time of your 
system, and allows you to achieve optimum system performance.

Only a Thermo Fisher Scientific customer support engineer can perform services not 
described in this manual.

CAUTION  Use Care When Changing Vacuum Pump Oil. Treat drained vacuum pump 
oil and pump oil reservoirs with care. Hazardous compounds introduced into the system 
might have become dissolved in the pump oil. Always use approved containers and 
procedures for disposing of waste oil. Whenever a pump has been operating on a system 
used for the analysis of toxic, carcinogenic, mutagenic, or corrosive/irritant chemicals, the 
pump must be decontaminated by the user and certified to be free of contamination 
before repairs or adjustments are made by a Thermo Fisher Scientific San Jose Customer 
Support Engineer or before it is sent back to the factory for service.

Solvent source Telephone number

Fisher Global Chemicals Tel: (800) 766-7000

Mallinckrodt/Baker, Inc. Tel: (800) 582-2537
Fax: (908) 859-9370

Burdick & Jackson, Inc. Tel: (800) 368-0050
Fax: (616) 725-6216
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Level of Repair
Thermo Fisher Scientific’s service philosophy for the TSQ system calls for troubleshooting to 
the lowest part, assembly, or module listed in Chapter 8, “Replaceable Parts.” 

For mechanical failures: A mechanical assembly typically is to be repaired to the level of the 
smallest item listed in Chapter 8, “Replaceable Parts.” 

Contacting Us
There are several ways to contact Thermo Fisher Scientific for the information you need. 

To contact Technical Support

Find software updates and utilities to download at mssupport.thermo.com.

To contact Customer Service for ordering information

To copy manuals from the Internet

Go to mssupport.thermo.com and click Customer Manuals in the left margin of the 
window. 

To suggest changes to documentation or to Help

• Complete a brief survey about this document by clicking the link below. Thank you 
in advance for your help. 

• Send an e-mail message to the Technical Publications Editor at 
techpubs-lcms@thermofisher.com.

Phone 800-532-4752
Fax 561-688-8736
E-mail us.techsupport.analyze@thermofisher.com
Knowledge base www.thermokb.com

Phone 800-532-4752
Fax 561-688-8731
E-mail us.customer-support.analyze@thermofisher.com
Web site www.thermo.com/ms
xviii TSQ Series Hardware Manual Thermo Scientific
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Introduction

TSQ™ Series mass spectrometers are members of the Thermo Scientific family of mass 
spectrometers. The TSQ Series mass spectrometer is an advanced analytical instrument that 
includes a syringe pump, a divert/inject valve, a mass spectrometer, and the Xcalibur™ data 
system. 

In a typical analysis, a sample can be introduced in the following ways:

• Using the syringe pump (direct infusion)

• Using the divert/inject valve fitted with a sample loop and LC (flow injection analysis) 

• Using the divert/inject valve and HPLC fitted with a column (LC/MS) 

In a typical analysis, a liquid chromatograph (LC) introduces a sample. The LC separates the 
sample into its various components. The components elute from the LC and pass into the 
mass spectrometer where they are analyzed. 

Analysis by direct infusion or flow injection provides no chromatographic separation of 
components in the sample before they pass into the mass spectrometer. The data from the 
mass spectrometer is then stored and processed by the data system.

The TSQ mass spectrometer consists of an atmospheric pressure ionization (API) source, ion 
optics, triple-stage mass analyzer, and ion detection system. A vacuum manifold encloses the 
ion optics, mass analyzer, ion detection system, and part of the API source. Ionization of the 
sample takes place in the API source. The specific process used to ionize the sample is known 
as the ionization mode. The ion optics transmit the ions produced in the ion source into the 
mass analyzer, where they are separated according to their mass-to-charge ratio. The polarity 

Contents

• Ionization Modes

• Ion Polarity Modes

• Scan Modes

• Scan Types

• Data Types

• Mass/Charge Range
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of the potentials applied to the lenses in the ion source and ion optics determines whether 
they transmit positively charged ions or negatively charged ions to the mass analyzer. You can 
configure the TSQ mass spectrometer to analyze positively or negatively charged ions (called 
the positive or negative ion polarity mode). 

The TSQ instrument’s triple-stage mass analyzer performs either one or two stages of mass 
analysis:

• The TSQ system is operated as a conventional mass spectrometer with one stage of mass 
analysis. The ion source ionizes the sample and the ion products are subjected to mass 
analysis in the first rod assembly. The second and third rod assemblies transmit the 
resulting mass-selected ions to the ion detection system.1

• The TSQ system is operated as a tandem mass spectrometer with two stages of mass 
analysis. The ion source ionizes the sample and the ion products are mass analyzed by the 
first rod assembly. In this case, however, mass-selected ions exiting the first rod assembly 
collide with an inert gas in the second rod assembly and fragment to produce a set of ions 
known as product ions. (A chamber called the collision cell surrounds the second rod 
assembly. The collision cell can be pressurized with an inert gas.) The product ions 
undergo further mass analysis in the third rod assembly to detect selected ions. Two stages 
of mass analysis yield far greater chemical specificity than a single stage can achieve, 
because of the system’s ability to select and determine two discrete but directly related sets 
of masses.

In a first stage of mass analysis the TSQ systems can be used to elucidate the structures of pure 
organic compounds and the structures of the components within mixtures. Furthermore, in a 
second stage of mass analysis, the mass spectrometer can fragment and separate each ionic 
fragment of a molecule formed in the ion source to build up an entire structure for the 
molecule, piece by piece. Thus, TSQ systems make investigating all pathways for the 
formation and fragmentation of each ion in the mass spectrum possible.

The two stages of mass analysis, with resultant reduction of chemical noise in the final mass 
spectrum, allow for very selective and sensitive analysis.

Each sequence of single- or triple-stage mass analysis of the ions is called a scan. The TSQ 
mass spectrometer uses several different scan modes and different scan types to filter, 
fragment, or transmit ions in the mass analyzer. Along with the ionization and ion polarity 
modes, the ability to vary the scan mode and scan type affords the user great flexibility in the 
instrumentation for solving complex analytical problems.

1 The instrument can also be used as a single-stage mass spectrometer by transmitting the ions through the first 
and second rod assemblies followed by mass analysis in the third rod assembly.
2 TSQ Series Hardware Manual Thermo Scientific
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Ionization Modes
The atmospheric pressure ionization (API) source forms gas phase sample ions from sample 
molecules that elute from the LC or are introduced by the syringe pump. You can operate the 
API source in the electrospray ionization (ESI) mode or, optionally, the heated electrospray 
ionization (H-ESI), nanospray ionization (NSI), atmospheric pressure photo ionization 
(APPI), or atmospheric pressure chemical ionization (APCI) mode. Refer to the Ion MAX 
and Ion MAX-S API Source Hardware Manual, HESI-II Probe User Guide, H-ESI Probe User 
Guide, Ion MAX APPI Source Operator’s Manual, or Nanospray Ion Source Operator’s Manual 
for more information regarding the ionization modes.

Ion Polarity Modes
You can operate the TSQ mass spectrometer in either of two ion polarity modes: positive or 
negative. Both positively charged and negatively charged ions form in the ion source of the 
mass spectrometer. The TSQ mass spectrometer can control whether positive ions or negative 
ions are transmitted to the mass analyzer for mass analysis by changing the polarity of the 
potentials applied to the ion source and ion optics. The ion optics deliver the ions produced 
in the ion source, in a collimated beam, to the mass analyzer.

The information obtained from a positive ion mass spectrum is different from and 
complementary to the information from a negative ion spectrum. Thus, the ability to obtain 
both positive ion and negative ion mass spectra aids you in the qualitative analysis of your 
sample. You can choose the ion polarity mode and ionization mode to obtain maximum 
sensitivity for the particular analyte of interest.

Scan Modes
You can operate the TSQ mass spectrometer in a variety of scan modes. The most commonly 
used scan modes can be divided into two categories: single mass spectrometry (MS) scan 
modes and MS/MS scan modes. The scan modes in each category are as follows:

• MS scan modes: Q1MS and Q3MS scan modes 

• MS/MS scan modes product scan mode, parent scan mode, neutral loss scan mode 

• Data-dependent scan mode

The scan modes that can be employed depend on the number and type of rod assemblies and 
the voltages applied to the rod assemblies.
Thermo Scientific TSQ Series Hardware Manual 3
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Scan Modes
The TSQ system mass analyzer has three rod assemblies.2 The first and third rod assemblies, 
Q1 and Q3, are quadrupoles, and the second rod assembly, Q2, is a square-profile 
quadrupole. 

Rod assemblies can operate in either of two capacities:

• As ion transmission devices

• As mass analyzers

If only RF voltage is applied, a rod assembly serves as an ion transmission device that passes all 
ions within a large range of mass-to-charge ratios (that is, virtually all ions present).

When you apply both RF and dc voltages to a rod assembly, the separation of ions of different 
mass-to-charge ratios occurs. This separation allows the rod assembly to serve as a mass 
analyzer.

On the TSQ mass spectrometer, the quadrupole rod assemblies can operate with RF and 
dc voltages or with only RF voltage. That is, Q1 and Q3 can act either as mass analyzers or 
ion transmission devices. The Q2 rod assembly operates exclusively with RF voltage. Thus, 
Q2 is always an ion transmission device. For a summary of how the rod assemblies function in 
several of the major scan modes, see Table 1.
.

a Scan = full scan or transmission of selected ions
b Pass all ions or fragments = pass ions or fragments within a wide range of mass-to-charge ratios
c Set = set to pass ions of a single mass-to-charge ratio or a set of mass-to-charge ratios
d Fragment ions = collisions with argon gas cause ions to fragment

2 A rod assembly is a regular array of metal rods. See “Mass Analyzer” on page 28 for a discussion of the rod 
assemblies used on the TSQ Series instrument.

Table 1. Summary of scan modes

Scan mode Q1 quadrupole Q2 collision cell Q3 quadrupole 

Q1MS Scana Pass all ionsb Pass all ions

Q3MS Pass all ions Pass all ions Scan

Product Setc Fragment ionsd, then pass all 
fragments

Scan

Parent Scan Fragment ions, then pass all 
fragments

Set

Neutral Loss Scan Fragment ions, then pass all 
fragments

Scan
4 TSQ Series Hardware Manual Thermo Scientific
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Scan Modes
Q1MS and Q3MS Scan Modes

The Q1MS and Q3MS scan modes perform only one stage of mass analysis. The mass 
spectrum obtained is equivalent to the mass spectrum obtained from an instrument with a 
single mass analyzer. In the one stage of analysis, ions formed in the ion source enter the 
analyzer assembly. One of the mass analyzers (Q1 or Q3) is scanned to obtain a complete mass 
spectrum. The other rod assemblies (Q2 and Q3, or Q1 and Q2, respectively) act as ion 
transmission devices. In the Q1MS scan mode, Q1 is used as the mass analyzer; in the Q3MS 
scan mode, Q3 is used as the mass analyzer.

Product Scan Mode

Product scan mode performs two stages of analysis. In the first stage, ions formed in the ion 
source enter Q1, which is set to transmit ions of one mass-to-charge ratio. Ions selected by 
this first stage of mass analysis are called parent ions. (As a result, Q1 is referred to as the 
parent mass analyzer, and the mass-to-charge ratio of ions transmitted by the parent mass 
analyzer is referred to as the parent set mass.) Parent ions selected by Q1 then enter Q2, which 
is surrounded by the collision cell.

In the second stage of analysis, ions in the collision cell can fragment further to produce 
product ions. Two processes produce product ions: by unimolecular decomposition of 
metastable ions or by interaction with argon collision gas present in the collision cell. This 
latter step is known as collision-induced dissociation (CID). Ions formed in the collision cell 
enter Q3 (the product mass analyzer) for the second stage of mass analysis. Q3 is scanned to 
obtain a mass spectrum that shows the product ions produced from the fragmentation of the 
selected parent ion.

A mass spectrum obtained in the product scan mode (product mass spectrum) is the mass 
spectrum of a selected parent ion.

Figure 1 illustrates the product scan mode.

Note  For convenience, when referring to the first, second, and third rod assemblies as 
pieces of hardware, you can call them Q1, Q2, and Q3, respectively. However, for clarity 
when discussing their function in MS/MS scan modes, you can refer to them as the parent 
mass analyzer, collision cell (ion transmission device surrounded by the collision cell), and 
product mass analyzer, respectively. 
Thermo Scientific TSQ Series Hardware Manual 5
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Figure 1. Illustration of product scan mode

Parent Scan Mode

The parent scan mode also uses two stages of analysis. In the first stage, ions formed in the ion 
source are introduced into the parent mass analyzer, which is scanned to transmit parent ions 
sequentially into the collision cell.

In the second stage of analysis, in the collision cell, parent ions can fragment to produce 
product ions by unimolecular decomposition of metastable ions or by collision-induced 
dissociation. Ions formed in the collision cell enter the product mass analyzer, which transmits 
a selected product ion. (The product set mass is the mass-to-charge ratio of ions transmitted 
by the product mass analyzer.)

The resultant spectrum shows all the parent ions that fragment to produce the selected 
product ion. Note that for a mass spectrum obtained in the parent scan mode (parent mass 
spectrum), data for the mass-to-charge ratio axis is obtained from Q1 (the parent ions), 
whereas data for the ion intensity axis is obtained from Q3 (from monitoring the product 
ion).

Figure 2 illustrates the parent scan mode.

Q2
RF Only + Ar

Q1 Set Q3 Scanning

Q3 m/z
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Figure 2. Illustration of the parent scan mode

Experiments that employ the parent scan mode (parent experiments) can be used in structure 
and fragmentation studies as well as in survey analyses of mixtures. In general, parent 
experiments detect all compounds that decompose to a common fragment. The experiments 
are useful for the rapid detection of a series of structural homologs (for example, substituted 
aromatics, phthalates, steroids, or fatty acids) that have a common fragment ion (for example, 
m/z 149 for the phthalates).

Neutral Loss Scan Modes

In the neutral loss scan mode, the two mass analyzers (Q1 and Q3) are linked together so that 
they are scanned at the same rate over mass ranges of the same width. The respective mass 
ranges, however, are offset by a selected mass so that the product mass analyzer scans a selected 
number of mass units lower than the parent mass analyzer.

As a result, in the neutral loss scan mode, there are two stages of mass analysis. In the first 
stage, the parent mass analyzer separates ions formed in the ion source by mass-to-charge 
ratio. Then the ions are introduced sequentially into the collision cell.

In the second stage of analysis, ions admitted to the collision cell can fragment further by 
metastable ion decomposition or by CID to produce product ions. The product mass analyzer 
then separates these product ions by their mass-to-charge ratio. Figure 3 illustrates the neutral 
loss scan mode. Examples of compounds with a common neutral loss fragment appear in 
Figure 4.

For an ion to be detected, between the time the ion leaves Q1 and enters Q3, it must lose a 
neutral moiety whose mass (the neutral loss mass) is equal to the difference in the mass ranges 
being scanned by the two mass analyzers. Thus, a neutral loss mass spectrum is a spectrum 
that shows all the parent ions that lose a neutral species of a selected mass.

Q2
RF Only + Ar

Q1 Scanning Q3 Set

Q1 m/z
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Note that a neutral gain (or association) experiment can also be performed in which the mass 
range scanned by Q3 is offset by a selected mass above the mass range scanned by Q1. 

For a neutral loss (or neutral gain) mass spectrum, as for a parent mass spectrum, Q1 (the 
parent ion) provides data for the mass-to-charge ratio axis, whereas Q3 (the product ion being 
monitored) provides data for the ion intensity axis.

Experiments that use the neutral loss scan mode (neutral loss experiments) are useful when a 
large number of compounds are being surveyed for common functionality. Neutral moieties 
are frequently lost from substituent functional groups (for example, CO2 from carboxylic 
acids, CO from aldehydes, HX from halides, and H2O from alcohols).

Figure 3. Illustration of the neutral loss scan mode

Q2
RF Only + Ar

Q1 Scanning Q3 = Q1 - Δ

Q1 m/z
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Figure 4. Examples of compounds with a common neutral-loss fragment

Data Dependent Scan Mode

The TSQ mass spectrometer uses the information in a data-dependent scan mode experiment 
to make automatic decisions about the next step of the experiment without input from a user. 
In data-dependent scan mode you specify criteria to select one or more ions of interest on 
which to perform subsequent scans, such as MS/MS. You can approach the setup of 
data-dependent experiments in either of two ways:

• If you have some idea of what the parent ion is, or if you expect a certain kind of parent, 
you can set up a list of possible parent ions. Then, when one of the parent ions you 
specified is detected, you can acquire product spectra and analyze the information. 
Conversely, you can also set up a list of ions that you do not want selected for 
fragmentation.

• If you have little information about your compound, you can set up the parameters of a 
data-dependent experiment so that if the intensity of the ion signal is above a specified 
threshold, the TSQ system generates product spectra. Later, you can decide if the 
information is useful. 

Because a data-dependent scan needs to use a target ion from a previous scan, the first scan 
event cannot be a data-dependent scan. 
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Scan Types
TSQ systems can be operated with a variety of scan types. The most common scan types are as 
follows:

• Full Scan

• Selected Ion Monitoring (SIM)

• Selected Reaction Monitoring (SRM)

• AutoSIM

Full Scan

The full-scan scan type provides a full mass spectrum of each analyte. With full scan, the 
scanning mass analyzer is scanned from the first mass to the last mass, without interruption, 
in a given scan time.

Full-scan experiments are used to determine or confirm the identity of unknown compounds 
or the identity of each component in a mixture of unknown compounds. (Generally, a full 
mass spectrum is needed to determine the identity of an unknown compound.) 

The full-scan scan type gives you more information about an analyte than does SIM, but a full 
scan does not yield the sensitivity that the other two scan types can achieve. With full scan, 
you spend less time monitoring the signal for each ion than you do in SIM or SRM. Full scan 
provides greater information but lower sensitivity than the other two scan types.

To use the SIM or SRM, you need to know what ions or reactions you are looking for before 
you can perform an experiment with these scan types. Thus, you might use a full scan for SIM 
to determine the identity of an analyte and to obtain its mass spectrum and a full scan for 
SRM to determine the mass spectrum and product mass spectra for parent ions of interest. 
Then, you might use SIM or SRM to do routine quantitative analysis of the compound.

Selected Ion Monitoring

Selected ion monitoring (SIM) monitors a particular ion or set of ions. SIM experiments are 
useful in detecting small quantities of a target compound in a complex mixture when you 
know the mass spectrum of the target compound. Thus, SIM is useful in trace analysis and in 
the rapid screening of a large number of samples for a target compound.

Because SIM monitors only a few ions, it can provide lower detection limits and greater speed 
than the full-scan modes. SIM achieves lower detection limits because more time is spent 
monitoring significant ions that are known to occur in the mass spectrum of the target 
analyte. SIM can achieve greater speed because it monitors only a few ions of interest; SIM 
does not monitor regions of the spectrum that are empty or have no ions of interest.
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SIM can improve the detection limit and decrease analysis time, but it can also reduce 
specificity. Because SIM monitors only specific ions, any compound that fragments to 
produce those ions will appear to be the target compound. The result can be a false positive.

Selected Reaction Monitoring

Selected reaction monitoring (SRM) monitors a particular reaction or set of reactions, such as 
the fragmentation of an ion or the loss of a neutral moiety.

SRM monitors a limited number of parent or product ion pairs. In product-type experiments, 
a parent ion is selected as usual, but generally only one product ion is monitored. SRM 
experiments are normally conducted with the product scan mode.

As does SIM, SRM provides for the very rapid analysis of trace components in complex 
mixtures. However, because SRM selects two sets of ions, it obtains specificity that is much 
greater than what SIM can obtain. Any interfering compound would not only have to form 
an ion source product (parent ion) of the same mass-to-charge ratio as the selected parent ion 
from the target compound, but that parent ion would also have to fragment to form a product 
ion of the same mass-to-charge ratio as the selected product ion from the target compound.

AutoSIM

In the scan type known as AutoSIM, the mass spectrometer automatically selects the most 
intense masses (m/z values) in a survey scan, builds a SIM scan list for them, and then acquires 
and records ion current at only these selected masses. AutoSIM scans can be performed on any 
full scan in any scan mode but not on data-dependent scans.

There might be times when the scan ranges of two (or more) selected masses overlap. If this 
happens, both masses are placed in one SIM window. In EZ Tune, the SIM table in the 
Define Scan dialog box displays the center mass for this new scan window, not each selected 
mass.

Data Types
You can acquire and display mass spectral data (intensity versus mass-to-charge ratio) with the 
TSQ mass spectrometer in one of two data types:

• Profile Data Type

• Centroid Data Type
Thermo Scientific TSQ Series Hardware Manual 11
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Profile Data Type

In the profile data type, you can see the shape of the peaks in the mass spectrum. Each atomic 
mass unit is divided into many sampling intervals. The intensity of the ion current is 
determined at each of the sampling intervals. The profile data type displays the intensity at 
each sampling interval with the intensities connected by a continuous line. In general, use the 
profile scan data type when you tune and calibrate the mass spectrometer so that you can 
easily see and measure mass resolution.

Centroid Data Type

The centroid data type displays the mass spectrum as a bar graph and sums the intensities of 
each set of multiple sampling intervals. This sum is displayed versus the integral center of 
mass of the sampling intervals. In general, use the centroid scan data type for data acquisition 
for faster scan speed. Data processing is also much faster for centroid data.

Mass/Charge Range
The TSQ mass spectrometer can operate in a mass/charge range of 10 to 3000 Da (TSQ 
Quantum™ Access™, TSQ Quantum Access MAX, TSQ Vantage EMR™, and TSQ Quantum 
Ultra EMR™) or 10 to 1500 Da (TSQ Vantage™, TSQ Vantage AM, TSQ Quantum Ultra™ 
and TSQ Quantum Ultra AM).
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Functional Description

This chapter describes the principal components of the TSQ system and their respective 
functions. 

A functional block diagram of the TSQ mass spectrometer is shown in Figure 5. A sample 
transfer line connects the LC to the mass spectrometer. The autosampler and LC are usually 
installed on the left of the mass spectrometer. The syringe pump and divert/inject valve are 
integrated into the mass spectrometer cabinet.

In a typical analysis, a sample can be introduced in any of the following ways:

• Using the syringe pump (direct infusion)

• Using the divert/inject valve fitted with a loop and an LC (flow injection analysis) 

• Using a divert/inject valve and LC fitted with a column (LC/MS) 

In analysis by LC/MS, a sample is injected onto an LC column. The sample then separates 
into its various components. The components elute from the LC column and pass into the 
mass spectrometer where they are analyzed. 

Electrospray ionization (ESI), heated electrospray ionization (H-ESI), nanospray ionization 
(NSI), atmospheric pressure photo ionization (APPI), or atmospheric pressure chemical 
ionization (APCI) ionize sample molecules at atmospheric pressure. The ion optics focus and 
accelerate the resulting sample ions into the mass analyzer where they are analyzed according 
to their mass-to-charge ratios. An ion detection system then produces a signal proportional to 
the number of ions detected. The system electronics receive and amplify the ion current signal 
from the ion detection system. That signal is then passed on to the data system for further 
processing, storage, and display. The data system provides the primary TSQ mass 
spectrometer user interface.

Contents

• Autosampler (optional)

• Liquid Chromatograph (optional)

• Mass Spectrometer

• Data System
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Autosampler
Figure 5. Functional block diagram of the TSQ system

Autosampler
The (optional) autosampler injects samples automatically into the liquid chromatograph (LC) 
inlet. The TSQ data system computer can control most autosamplers. With an autosampler, 
you can automate your LC/MS analyses.

Autosampler Start/Stop signals with the TSQ mass spectrometer are provided by contact 
closure. Refer to the TSQ Series Getting Connected Guide for information on connecting an 
autosampler to the TSQ mass spectrometer by contact closure.

You configure the autosampler from the data system computer. Select the appropriate 
autosampler button in the Instrument Configuration window, which is available by choosing 
Start > All Programs > Thermo Foundation > Instrument Configuration. See Instrument 
Configuration Help for a description of autosampler configuration options.

You also use the data system to set up the autosampler to inject samples. Choose 
Start > All Programs > Thermo Xcalibur > Xcalibur and click Instrument Setup to open 
the Instrument Setup window. Then, click the appropriate autosampler icon to open the 
Autosampler page. For instructions on running your autosampler, refer to the Help.

For front-panel (keypad) operation (if any) and maintenance procedures, refer to the 
documentation provided with the autosampler.
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(optional)

LC (optional) 
or

syringe pump

API
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Ion
optics

Mass
analyzer
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system

Instrument
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electronic
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Liquid Chromatograph
The (optional) liquid chromatograph (LC) separates a sample mixture into its chemical 
components by liquid chromatography. In liquid chromatography, the sample mixture 
partitions between a solid stationary phase of large surface area and a liquid mobile phase that 
percolates over the stationary phase. The molecular structure of each component of the 
mixture determines in which order each component elutes from the LC and enters the mass 
spectrometer.

You can control most LCs and the corresponding UV detectors directly from the TSQ data 
system computer. You can set the flow rate from 0 to 1000 μL/min or more. Refer to the 
TSQ Series Getting Connected Guide for information on connecting an LC to the TSQ mass 
spectrometer.

You configure the LC from the data system computer. Select the appropriate LC button in the 
Instrument Configuration window, which is available by choosing Start > All Programs > 
Thermo Foundation > Instrument Configuration. For a description of LC configuration 
options, refer to Xcalibur Help. 

You also use the data system to set up the LC. Choose Start > All Programs > 
Thermo Xcalibur > Xcalibur and click Instrument Setup to open the Instrument Setup 
window. Then, click the appropriate LC icon to open the LC page. For instructions on 
running your LC, refer to the Help.

For front-panel (keypad) operation (if any) and maintenance procedures, refer to the 
documentation provided with the LC.

Syringe Pump
The TSQ mass spectrometer includes an electronically-controlled, integrated syringe pump. 
See Figure 6. The syringe pump delivers sample solution from the syringe into the 
atmospheric pressure ionization (API) source. When the syringe pump is operating, a motor 
drives a pusher block that depresses the plunger of the syringe at a rate of one percent of the 
syringe volume per minute. Liquid flows out of the syringe needle and into the sample 
transfer line as the plunger is depressed. A syringe holder holds the syringe in place. Refer to 
the TSQ Series Getting Started Guide or the TSQ Series Getting Connected Guide for 
instructions on setting up the syringe pump. 

You can start and stop the syringe pump from the EZ Tune window, which is available by 
choosing Start > All Programs > Thermo Instruments > TSQ > TSQ Tune. Refer to 
EZ Tune Help for instructions on operating the syringe pump from the data system. You can 
also start and stop the syringe pump by pressing the syringe pump button. By holding down 
the button, you can run the syringe pump in Purge mode, where the flow rate is five percent 
of the syringe volume per second.
Thermo Scientific TSQ Series Hardware Manual 15



2 Functional Description
Divert/Inject Valve
The syringe pump light-emitting diode (LED) (see Figure 9 and Figure 10) illuminates green 
whenever the syringe pump is pumping. The LED illuminates yellow if the syringe pump is at 
the end of its travel.

Figure 6. Syringe pump

Divert/Inject Valve
The Rheodyne™ 7750E-185 divert/inject valve is a motorized, stainless steel, six-port valve 
that switches between two positions: Load and Inject. The divert/inject valve is located on the 
front of the TSQ mass spectrometer above the API source. See Figure 7. You can configure 
(plumb) the divert/inject valve as a loop injector (for flow injection analysis) or as a divert 
valve. See Figure 8. The divert valve enables switching the solvent front, gradient endpoint, or 
any portion of the LC run to waste. The TSQ Series Getting Started Guide provides procedures 
for plumbing the valve in the loop injector or divert valve configuration.

You can control the divert/inject valve from the data system. You specify the parameters of the 
divert/inject valve on the Divert Valve page, accessible from the Instrument Setup window. 
For instructions on operating the divert/inject valve from the data system, refer to the Help.

You can also use the divert/inject valve button to divert the LC flow between the mass 
spectrometer and waste when the valve is in the divert valve configuration, or switch between 
load and inject modes when the valve is in the loop injector configuration.

Pusher block

Syringe holder

Syringe

Needle

LC union
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Divert/Inject Valve
Figure 7. Divert/inject valve

Figure 8. Divert/inject valve plumbed as a loop injector and as a divert valve 
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Mass Spectrometer
The mass spectrometer provides sample ionization and mass analysis of injected samples or 
samples eluted from a liquid chromatograph. The TSQ mass spectrometer uses a 
triple-quadrupole mass analyzer with an ion source external to the mass analyzer. Several 
important features of the TSQ mass spectrometer are as follows:

• High sensitivity and resolution

• m/z 10 to 3000 mass range for TSQ Quantum Access, TSQ Quantum Access MAX, and 
TSQ Vantage and TSQ Quantum Ultra with extended mass range (EMR) electronic 
assemblies installed; and m/z 10 to 1500 mass range for TSQ Vantage, TSQ Vantage AM, 
TSQ Quantum Ultra, and TSQ Quantum Ultra AM without extended mass range 
electronic assemblies

• ESI, H-ESI, NSI, APPI, and APCI ionization modes

• Positive and negative ion polarity modes

• MS and MS/MS scan modes 

• Full-scan, SIM, SRM, AutoSIM, and data-dependent scan types

The mass spectrometer includes the following components:

• Controls and Indicators

• API Source

• Ion Source Interface

• Ion Optics

• Mass Analyzer

• Ion Detection System

• Vacuum System and Inlet Gases Hardware

• Electronic Assemblies 
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Controls and Indicators

Six LEDs are located at the upper right side of the front panel of the mass spectrometer. 
See Figure 9 (TSQ Vantage, TSQ Quantum Access, or TSQ Quantum Access MAX) and 
Figure 10 (TSQ Quantum Ultra).

Figure 9. Front panel LEDs of the TSQ Vantage, TSQ Quantum Access, or TSQ Quantum Access 
MAX mass spectrometer

Figure 10. Front panel LEDs of the TSQ Quantum Ultra mass spectrometer

The Power LED illuminates green whenever power is supplied to the vacuum system and 
electronic assemblies of the mass spectrometer. 

The Vacuum LED illuminates yellow when the turbomolecular pump is nearly at speed 
(80 percent of its operating speed of 750 MHz) and it is safe to turn on the ion gauge. The 
Vacuum LED is off if the turbomolecular pump is not at speed. The Vacuum LED 
illuminates green whenever the pressure in the analyzer chamber is at or below the value 
required to enable high voltages to the mass analyzer (7 × 10-4 Torr). 

The Communication LED illuminates yellow when the mass spectrometer and the data 
system are trying to establish a communication link. The Communication LED illuminates 
green when the Ethernet communication link between the mass spectrometer and the data 
system has been made. 

The System LED illuminates yellow whenever the mass spectrometer is in standby—that is, 
high voltage is not supplied to the ion source, mass analyzer, or ion detection system, but the 
mass spectrometer power is on. The System LED illuminates green whenever the high voltage 
is enabled and the system is in the On state. High voltage is enabled if the analyzer chamber is 
below 7 × 10-4 Torr.

The Scan LED flashes blue whenever the mass spectrometer is on and is scanning ions.

The syringe pump LED illuminates green whenever the syringe pump is pumping. The LED 
illuminates yellow if the syringe pump is at the end of its travel.

Power Vacuum Communication Syringe PumpScanSystem

Power Vacuum Communication Syringe Pump

System Scan
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Two additional LEDs and a push-button switch are located on the front panel above the 
divert/inject valve. See Figure 11. When the divert/inject valve is set up for loop injections, 
the divert/inject valve button switches the valve between load and inject modes and the 
labels Load and Inject apply.

Figure 11. Divert/inject valve button and LEDs

When the divert/inject valve is set up for divert valve operation, the divert/inject valve button 
switches the LC flow between the mass spectrometer and the waste container and the labels 
Detector and Waste apply.

The main power circuit breaker switch (labeled Main Power) is located on the power panel at 
the lower right corner of the right side panel of the mass spectrometer. See Figure 12 and 
Figure 13. In the Off (O) position, the circuit breaker removes all power to the mass 
spectrometer, including the vacuum pumps. In the On (|) position, power is supplied to the 
mass spectrometer. In the standard operational mode, the circuit breaker is kept in the On (|) 
position.

Figure 12. Power panel of the TSQ Vantage or TSQ Quantum Ultra
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Figure 13. Power panel of the TSQ Quantum Access or TSQ Quantum Access MAX, showing 
switches and LEDs

The electronics service switch (labeled Electronics) is located next to the main power circuit 
breaker on the mass spectrometer power panel (Figure 12 and Figure 13). In the Service Mode 
position the switch removes power to all components of the mass spectrometer other than the 
vacuum system. The Operating Mode position supplies power to all non-vacuum system 
components of the mass spectrometer. 

On the TSQ Quantum Access and TSQ Quantum Access MAX, a vacuum service switch 
(labeled Vacuum) is located next to the Electronics service switch on the mass spectrometer 
power panel (Figure 13). In the Service Mode position the switch removes power to all 
components of the vacuum system, including the forepump, turbomolecular pump, and 
turbomolecular pump controller. The switch in the Operating Mode position supplies power 
to all vacuum system components of the mass spectrometer. 

The System Reset button is also located on the mass spectrometer power panel. Pressing the 
System Reset button causes the embedded computer on the System Control PCB to reboot. 
The TSQ mass spectrometer software is then reloaded from the data system. See “Resetting 
the Mass Spectrometer” on page 55 for information on how to reset the mass spectrometer.

Three LEDs are located on the power panel: 

• The Pump On LED illuminates green when the forepump current sensor detects current 
to the forepump. The LED is off when the forepump current sensor does not detect 
current to the forepump. If the current sensor detects a loss of current when the TSQ is 
on, high voltage turns off and the vacuum system vents.
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• The Vent Valve Closed LED illuminates green whenever the vent valve current sensor 
detects current through the vent valve and the vent valve is closed. The LED is off when 
the vent valve is open.

• The Ethernet Link OK LED illuminates green when the System Control PCB is 
communicating with the data system PC. The LED is off when there is no 
communication between the System Control PCB and the data system PC.

API Source

The atmospheric pressure ionization (API) source forms gas phase sample ions from sample 
molecules that elute from the LC or are introduced by the syringe pump. You can operate the 
API source in the electrospray ionization (ESI), heated electrospray ionization (H-ESI), 
nanospray ionization (NSI), atmospheric pressure photo ionization (APPI), or atmospheric 
pressure chemical ionization (APCI) mode. For more information regarding the API source, 
refer to the Ion Max and Ion Max-S API Source Hardware Manual, HESI-II Probe User Guide, 
H-ESI Probe User Guide, Ion Max APPI Source Operator’s Manual, or Nanospray Ion Source 
Operator’s Manual.

Ion Source Interface

The ion source interface consists of the components of the API source that are held under 
vacuum (except for the atmospheric pressure side of the ion sweep cone). The ion source 
interface includes an ion transfer tube, two cartridge heaters, a heater block, a platinum probe 
sensor, a vent prevent ball, and an ion sweep cone. See Figure 14.

CAUTION  In an emergency, to shut off all power to the mass spectrometer, place the Main 
Power circuit breaker switch (labeled Main Power) in the Off (O) position. 
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Figure 14. Cross-sectional view of the ion source interface, Q00 ion optics, and Q0 ion optics of the TSQ Quantum Access, 
TSQ Quantum Access MAX, or TSQ Quantum Ultra

The ion transfer tube assists in desolvating ions that are produced by the API probe. The tube 
is an elongated, 4 in. (on the TSQ Quantum Access, TSQ Quantum Access MAX, and 
TSQ Quantum Ultra) or 2.3 in. (on the TSQ Vantage) cylindrical metal tube. See Figure 15. 
Two heater cartridges are embedded in the heater block. The heater block surrounds the ion 
transfer tube and heats it to temperatures up to 400 °C. A platinum probe sensor measures the 
temperature of the heater block. Typical temperatures of the ion transfer tube are 270 °C for 
ESI and 250 °C for APCI, but these temperatures vary with flow rate and mobile phase 
composition. A decreasing pressure gradient draws ions into the ion transfer tube in the 
atmospheric pressure region and transports them to the ion transfer tube-skimmer region of 
the vacuum manifold. A potential of typically ±35 V (positive for positive ions and negative 
for negative ions) assists in repelling ions from the ion transfer tube to the skimmer. The vent 
prevent ball falls into the space occupied by the ion transfer tube when the tube is removed, 
thus preventing air from entering the vacuum manifold. The vent prevent ball allows you to 
remove the ion transfer tube for cleaning without venting the system.

Front

Heater blockIon transfer tube
Vent prevent ball

Ion sweep cone

Tube lens

Skimmer

Lens L0

Q0 quadrupole

Q00 rf lens
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The ion sweep cone is a metallic cone over the ion transfer tube. The ion sweep cone channels 
the sweep gas towards the entrance of the tube.

The ion source interface is enclosed in a vacuum chamber that is evacuated by the forepump 
to a pressure of approximately 1.5 Torr.

Figure 15. Ion transfer tube

Ion Optics

The ion optics focus the ions produced in the API source and transmit them to the mass 
analyzer. The TSQ mass spectrometer uses two ion optics elements:

• Q00 ion optics

• Q0 ion optics

Q00 Ion Optics

The Q00 ion optics are the ion optics that are located closest to the API source. Q00 ion 
optics include either the tube lens and skimmer or the S-lens and exit lens, the Q00 rf lens, 
the ion source interface cage, and the lens L0. See Figure 14.

On the TSQ Quantum Access, TSQ Quantum Access MAX, and TSQ Quantum Ultra, ions 
from the ion transfer tube enter the tube lens. See Figure 16. The tube lens has a 
mass-dependent potential applied to it to focus the ions toward the opening of the skimmer. 
An additional potential of between 0 and ±250 V (positive for positive ions and negative for 
negative ions), called the tube lens offset voltage, can be applied to the tube lens. This 
accelerates the ions into background gas that is present in the ion transfer tube-skimmer 
region. Collisions with the background gas aid in the desolvation of the ions and increase 
sensitivity. If the tube lens offset voltage is too high, however, collisions with the background 
gas can be energetic enough to cause ion fragmentation. This fragmentation, called ion source 
collision-induced dissociation (CID), decreases sensitivity. When you tune the TSQ mass 
spectrometer, you adjust the tube lens offset voltage to maximize sensitivity by balancing 
desolvation with fragmentation.

Front
24 TSQ Series Hardware Manual Thermo Scientific



 2 Functional Description
Mass Spectrometer
Figure 16. Tube lens of the TSQ Quantum Access, TSQ Quantum Access MAX, or TSQ Quantum 
Ultra

The TSQ Vantage uses an S-lens and exit lens rather than a tube lens and skimmer. The S-lens 
is an ion transmission device consisting of progressively-spaced, stainless-steel electrodes. See 
Figure 17. A 650 kHz rf voltage is applied to the electrodes, and adjacent electrodes have 
voltages of opposite phase. As the rf amplitude increases, ions of progressively higher 
mass-to-charge ratios pass through to the exit lens. During the tune procedure, the TSQ 
Vantage determines the mass-dependent rf amplitudes for optimum transmission of ions 
through the lens. The maximum amplitude is 300 V peak-to-peak.

Figure 17. S-lens of the TSQ Vantage

Ions from the tube lens or S-lens pass through the skimmer (Figure 18) or exit lens 
(Figure 19) and move toward the Q00 rf lens. The skimmer and exit lens act as a vacuum 
baffle between the higher pressure ion source interface region (at 1.5 Torr) and the lower 
pressure Q00 ion optics region (at 50 mTorr) of the vacuum manifold. The apertures of the 
skimmer and exit lens are offset with respect to the bore of the ion transfer tube. This 
arrangement reduces the number of large, charged particles that pass through the skimmer or 
exit lens into the mass analyzer, which reduces detector noise. The tube lens and skimmer, or 
the S-lens and exit lens, mount to the ion source interface cage. 

Rear

Front
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Figure 18. Skimmer of the TSQ Quantum Access, TSQ Quantum Access MAX, or TSQ Quantum 
Ultra

Figure 19. Exit lens of the TSQ Vantage

The Q00 rf lens is a square array of thin metal elements that act as an ion focusing device. See 
Figure 20. An rf voltage that is applied to the elements gives rise to an electric field that 
focuses the ions along the axis of the lens. A dc voltage offset from ground applied to Q00 
(called the Q00 offset voltage) increases the translational kinetic energy of ions emerging from 
the skimmer. During ion focusing, the offset voltage is negative for positive ions and positive 
for negative ions. Increasing the offset voltage increases the translational kinetic energy of the 
ions. Typical values of the Q00 offset voltage are 0 and ±4 V (negative for positive ions and 
positive for negative ions). 

Figure 20. Q00 rf lens
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Source CID can also be accomplished by increasing the dc voltage offset between the 
skimmer, which is at ground potential, and the rest of the mass spectrometer beginning with 
Q00. You use the Source CID parameter in the Tune Master software to adjust this potential.

The lens L0 is a metal cylinder with a small hole in one end through which the ion beam can 
pass. A potential of between 0 and ±3 V (negative for positive ions and positive for negative 
ions) is applied to lens L0 to aid in ion transmission. Lens L0 also acts as a vacuum baffle 
between the Q00 and Q0 ion optics chambers.

Q0 Ion Optics

The Q0 ion optics transmits ions from the Q00 ion optics to the mass analyzer. The Q0 ion 
optics includes the Q0 quadrupole and lenses L11 and L12.

The Q0 quadrupole is a square array of square-profile rods that act as an ion transmission 
device. See Figure 21. An rf voltage applied to the rods gives rise to an electric field that guides 
the ions along the axis of the quadrupole. The Q0 offset voltage increases the translational 
kinetic energy of ions emerging from Q00. 

Figure 21. Q0 quadrupole

The Q0 offset voltage can also be used to fragment ions. In ion source collision-induced 
dissociation, the offset voltage (typically –30 V to +30 V) imparts enough kinetic energy to 
the ions so that, when they collide with solvent or air molecules, the ions dissociate to form 
product ions. The translational kinetic energy imparted to the ions determines the degree of 
dissociation. At low energies, adduct ions convert to sample ions by collision-induced 
dissociation without fragmenting. At higher energies, molecular ions can fragment and 
thereby enable primitive MS/MS/MS analysis.

The L11 and L12 lenses are metal disks with a circular hole in the center through which the 
ion beam can pass. See Figure 22. Together they act as a two-element cone lens. An electrical 
potential applied to the lens accelerates (or decelerates) ions as they approach the lens to focus 
the ion beam as it passes through the lens. The value ranges between 0 and ±300 V. Lenses 
L11 and L12 also act as a vacuum baffle between the Q0 ion optics chamber and the mass 
analyzer chamber.
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Figure 22. Lenses L11 (left) and L12 (right)

Mass Analyzer

The mass analyzer separates ions according to their mass-to-charge ratio and then passes them 
to the ion detection system. The mass analyzer on the TSQ consists of three quadrupole rod 
assemblies (Q1, Q2, and Q3) and three lens sets. See Figure 23.

Figure 23. Mass analyzer, ion detection system, and ion optics
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The following subtopics discuss the mass analyzer in detail:

• Quadrupole Rod Assemblies

• RF and DC Fields Applied to the Quadrupoles

• Mass Analysis

• Collision Cell and CID Efficiency 

• Quadrupole Offset Voltage

• Mass Analyzer Lenses

Quadrupole Rod Assemblies

The three rod assemblies used in the TSQ mass spectrometer are numbered from the ion 
source end of the manifold and are designated Q1, Q2, and Q3. Q1 and Q3 are quadrupoles 
that enable high-resolution scans without signal loss. 

Q1 and Q3 are square arrays of precision-machined and precision-aligned, true hyperbolic 
quadrupoles, called hyperquads (TSQ Vantage and TSQ Quantum Ultra) or 
hyperbolic-profile round rods (TSQ Quantum Access and TSQ Quantum Access MAX). See 
Figure 24 and Figure 25. Quartz spacers act as electrical insulators between adjacent rods. 

Figure 24. Q1 or Q3 hyperquad of the TSQ Vantage or TSQ Quantum Ultra

Figure 25. Q1 or Q3 quadrupole of the TSQ Quantum Access, or TSQ Quantum Access MAX

Q2 is a square-profile quadrupole rod assembly. Q2 always acts as an ion transmission device. 
The Q2 quadrupole rods are bent through a 90-degree arc. In addition to reducing the 
footprint of the instrument, this bending of the rods prevents the transmission of unwanted 
neutral species to the detector and dramatically lowers the noise level in the data. Q2 has 
become synonymous with the term collision cell. Technically, the collision cell is the chamber 
that encloses Q2 where collision-induced dissociation can take place if the argon collision gas 
is present. See Figure 26.
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Figure 26. Collision cell (top), Q2 quadrupole (bottom), and lenses 

RF and DC Fields Applied to the Quadrupoles

In a quadrupole rod assembly, because rods opposite each other in the array connect 
electrically, the four rods can be considered as two pairs of two rods each. Ac and dc voltages 
are applied to the rods and these voltages are ramped during the scan. Voltages of the same 
amplitude and sign are applied to the rods of each pair. However, the voltages applied to the 
different rod pairs are equal in amplitude but opposite in sign. See Figure 27.

Figure 27. Polarity of the rf and dc voltages applied to the rods of the Q1 and Q3 mass analyzers 

The ac voltage applied to the quadrupole rods is of constant frequency (1.123 MHz). The rf 
voltage applied to the rods varies from 0 to 10000 V peak-to-peak, and the dc voltage varies 
from 0 to ±840 V. Voltages of the same amplitude and sign are applied to each rod pair. 
However, the voltages applied to the other rod pair are equal in amplitude but opposite in 
sign.

Lenses L21, L22, 
and L23

Lenses L31, L32, 
and L33

RF voltage
+ dc voltage

RF voltage 180° out of phase
– dc voltage
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Because the frequency of this ac voltage is in the radio frequency range, it is referred to as rf 
voltage. In Figure 28, the solid line represents the combined rf and dc voltage applied to one 
rod pair, and the dashed line represents the combined rf and dc voltage applied to the other 
rod pair. The ratio of rf voltage to dc voltage determines the ability of the mass spectrometer 
to separate ions of different mass-to-charge ratios.

The first and third quadrupole rod assemblies (Q1 and Q3 quadrupoles) can act as mass 
analyzers or as ion transmission devices. When both rf and dc voltages are applied, Q1 and 
Q3 function as mass analyzers. When only rf voltage is applied, they act as ion transmission 
devices. In the ion transmission mode, the quadrupole rod assemblies allow ions in a wide 
window of mass-to-charge ratios to pass.

The square quadrupole rod assembly (Q2) operates in the ion transmission mode only. 
Surrounding Q2 is a collision cell where collision-induced dissociation (CID) can take place if 
the argon collision gas is present in the cell.

Figure 28. Magnitude of the rf and dc voltages applied to the rods of the Q1 and Q3 mass 
analyzers 
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Mass Analysis

The mass analyzers (Q1 and Q3) are square arrays of precision-machined and 
precision-aligned hyperbolic or round-profile rods. The rods are charged with a variable ratio 
of rf voltage and dc voltage (Figure 28). These potentials give rise to an electrostatic field that 
gives stable oscillations to ions with a specific mass-to-charge ratio and unstable oscillations to 
all others.

At any given instant, one particular set of rf and dc voltage values is being applied to the mass 
analyzer rods. Under these conditions, only ions of one mass-to-charge ratio (for example, 
m/z 180) are maintained within bounded oscillations as their velocity carries them through 
the mass analyzer. At the same time, all other ions undergo unbounded oscillations. These 
ions strike one of the rod surfaces, become neutralized, and are pumped away, or they are 
ejected from the rod assembly.

Then, at a later time, both rf and dc voltages change, and ions of the next mass-to-charge ratio 
(for example, m/z 181) are allowed to pass, while all other ions (including m/z 180) become 
unstable and undergo unbounded oscillations. This process continues, with ions of one 
mass-to-charge ratio after another being transmitted, as the rf and dc voltages change in value. 
At the end of the scan, the rf and dc voltages are discharged to zero, and the process repeats.

The TSQ system can rapidly and precisely change the potentials on the quadrupole rods. The 
rf and dc voltages in the TSQ mass spectrometer can be scanned over the full mass range of 
the system, m/z 10 to 3000, in 0.85 seconds. 

The more closely the electrostatic field generated by a set of quadrupole rods approximates a 
hyperbolic geometry, the better their operating characteristics are. As a result, the precision 
quadrupole rods of the TSQ mass spectrometer provide excellent sensitivity, peak shape, 
resolution, and high mass transmission.

Collision Cell and CID Efficiency

In the MS/MS scan modes, the TSQ applies a large voltage of opposite polarity to the rod 
pairs between scans, which empties the collision cell. This process ensures that no ions remain 
in the collision cell from scan to scan.

The collision cell quadrupole rod assembly (Q2), which always acts as an ion transmission 
device, is a quadrupole array of square-profile rods. A variable rf voltage charges the rods, 
which creates an electrostatic field that gives stable oscillations to ions in a wide window of 
mass-to-charge ratios. 

The collision cell surrounds Q2 and is usually pressurized from about 1 × 10-3 to 4 × 10-3 Torr 
with argon collision gas. The collision cell is where collision-induced dissociation takes place.

CID is a process in which an ion collides with a neutral atom or molecule and then, because 
of the collision, dissociates into smaller fragments. The mechanism of dissociation involves 
converting some of the translational kinetic energy (TKE) of the ion into internal energy. This 
collision places the ion in an excited state. If the internal energy is sufficient, the ion 
fragments. 
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Three expressions convey the efficiency of the CID process:

• Collection efficiency

• Fragmentation efficiency

• Overall CID efficiency

Collection efficiency: The ion flux ratio measured at the exit of the collision cell and at its 
entrance. With no collision gas present, the TSQ obtains virtually 100 percent collection 
efficiency. Collection efficiency is a mass-dependent parameter. For example, with mid-range 
collision gas pressure, the collection efficiency might vary from about 50 percent for 
comparatively less massive ions (which are more prone to scatter) up to 75 percent for 
comparatively more massive ions (which are less prone to scatter). 

Fragmentation efficiency: The fraction of the ion flux at the exit of the collision cell that 
results from fragmented ions. Fragmentation efficiency depends directly on the stability of the 
ion and indirectly on the mass of the ion. The more stable the ion, the less likely a given 
collision will fragment the ion. The more massive the ion, the greater its ability to distribute 
the vibrational energy imparted by a collision. As a result, ion fragmentation might decrease.

With mid-range collision gas pressure, fragmentation efficiency might vary from 15 percent to 
65 percent for various compounds. As the collision gas pressure increases, the fragmentation 
efficiency for all compounds approaches 100 percent due to multiple collisions. The 
collection efficiency decreases, however, due to scattering.

Overall CID efficiency: The product of the collection efficiency and the fragmentation 
efficiency. The overall CID efficiency exhibits a maximum with intermediate pressure. As the 
pressure increases beyond the optimum value, more and more collisions take place, the 
probability of scattering increases, and fewer and fewer ions pass through the collision cell. 
Scattering results in the collection efficiency decreasing. The fragmentation efficiency also 
decreases as the pressure is decreased from its optimum value, because fewer and fewer 
collisions take place. 

Quadrupole Offset Voltage

The quadrupole offset voltage is a dc potential applied to the quadrupole rods in addition to 
the ramping dc voltage. The offset voltage applied to the two rod pairs of the assemblies is 
equal in amplitude and equal in sign. The quadrupole offset voltage accelerates or decelerates 
ions and, therefore, sets theTKE of the ions as they enter the quadrupole rod assembly. 

In general, for a given experiment, the TSQ has fixed offset voltages for Q1 and Q2. However, 
in MS/MS experiments, the quadrupole offset voltage applied to Q3 usually varies as a scan 
proceeds. The TSQ automatically computes the Q3 quadrupole offset voltage necessary and 
then varies the voltage, as appropriate, as each scan proceeds.
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The offset voltage applied to Q2 (which contains the collision cell) is responsible for the 
collision energy. The collision energy is the difference in potential between the ion source 
(where parent ions are formed) and Q2 (where they collide with collision gas). As the offset 
voltage on Q2 increases, the TKE of the parent ions also increases. As a result, increases in the 
Q2 offset voltage increase the energy of ion/Ar collisions. The collision energy is generally set 
to one value for an entire scan and can be set from 0 to ±200 V.

Before obtaining any mass spectra, the TSQ tunes Q1 in the Q1MS scan mode (Q2 and Q3 
rf voltage only), and tunes Q3 in the Q3MS scan mode (Q1 and Q2 rf voltage only). During 
tuning, the TSQ determines the optimum quadrupole offset voltage for Q1 and for Q3.

Mass Analyzer Lenses

The TSQ system mass analyzer has three lens sets. See Figure 26 on page 30. Those between 
Q1 and Q2 are designated L21, L22, L23; those between Q2 and Q3 are designated L31, 
L32, L33; and the lens between Q3 and the ion detection system is designated as L4 (or the 
exit lens). All of the lenses have circular holes in their centers through which the ion beam 
passes.

The lens assemblies also retain the three rod assemblies to ensure accurate and automatic axial 
alignment of the rod assemblies. 

The L2x lens set (between Q1 and Q2) and the L3x lens set (between Q2 and Q3) serve these 
functions:

• To minimize the amount of collision gas that enters the mass analyzers (Q1 and Q3) from 
the collision cell (Q2). (For high-mass transmission, it is important to maintain a low 
pressure in the mass analyzers.) 

• To retain the collision gas. Lenses L23 and L31 form two of the walls of the collision cell, 
so they tend to hold the collision gas in the collision cell. The collision gas escapes, 
however, through the same lens holes through which the ion beam passes.

• To prevent gas from entering the mass analyzers. Lenses L22 and L21 on one side of Q2 
and lenses L32 and L33 on the other side of Q2 act as baffles to help prevent the gas that 
escapes from the collision cell from entering the mass analyzers.

• To shield Q1 from the rf voltage applied to Q2 and vice versa (L2x lens set) and to shield 
Q3 from the rf voltage applied to Q2 and vice versa (L3x lens set).

• To focus the ion beam. The three lenses between Q1 and Q2 (and those between Q2 and 
Q3) together form a three-element aperture lens. The first and third lenses are generally 
set to similar or identical values and the central lens is set to a value different (either 
higher or lower) from the other two.
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The voltage applied to each of the lenses can vary from about –300 to +300 V. Typically, 
however, the voltage applied to the first and third elements of the L2x lens set is somewhat 
greater than the quadrupole offset voltage applied to Q1. Because the Q1 quadrupole offset 
voltage is generally set to about ±5 V (depending on the charge of the ions of interest), the 
voltage applied to lenses L21 and L23 is typically about –10 V for positive ions and +10 V for 
negative ions. The voltage applied to the central lens of the L2x lens set is typically about 
±225 V.

In the Q3MS scan mode, the voltage applied to the lenses of the L3x lens set is about the same 
as that applied to the corresponding lens in the L2x lens set. Note, however, that in the 
MS/MS scan modes, the voltage applied to the L3x lens set automatically varies with the 
quadrupole offset voltage applied to Q3. As the Q3 quadrupole offset voltage ramps, the 
voltages applied to the lenses ramp correspondingly. 

Lens L4 is located between Q3 and the ion detection system. L4 is held at ground potential. 
Its purpose is to shield Q3 from the high voltage applied to the ion detection system and to 
shield the ion detection system from the high rf voltages applied to Q3.

Ion Detection System

The TSQ mass spectrometer is equipped with a high-sensitivity, off-axis ion detection system. 
This system produces a high signal-to-noise ratio and allows for voltage polarity switching 
between positive ion and negative ion modes of operation. The ion detection system includes 
a 15 kV conversion dynode and a channel electron multiplier. See Figure 29. The ion 
detection system is located at the rear of the vacuum manifold behind the mass analyzer. 

The conversion dynode is a concave metal surface located at a right angle to the ion beam. 
The TSQ applies to the conversion dynode a potential of +15 kV for negative ion detection or 
–15 kV for positive ion detection. When an ion strikes the surface of the conversion dynode, 
one or more secondary particles are produced. These secondary particles can include positive 
ions, negative ions, electrons, and neutrals. When positive ions strike a negatively charged 
conversion dynode, the secondary particles of interest are negative ions and electrons. When 
negative ions strike a positively charged conversion dynode, the secondary particles of interest 
are positive ions. The curved surface of the conversion dynode focuses these secondary 
particles and a voltage gradient accelerates the particles into the electron multiplier. 

The electron multiplier includes a cathode and an anode. The cathode of the electron 
multiplier is a lead-oxide, funnel-like resistor. The high voltage ring applies a potential of up 
to –2.5 kV to the cathode. The exit end of the cathode (at the anode) is near ground 
potential. 

The anode of the electron multiplier is a small cup located at the exit end of the cathode. The 
anode collects the electrons produced by the cathode. The anode screws into the anode 
feedthrough in the base plate.

Secondary particles from the conversion dynode strike the inner walls of the electron 
multiplier cathode with sufficient energy to eject electrons. The ejected electrons are 
accelerated farther into the cathode, drawn by the increasingly positive potential gradient. 
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The funnel shape of the cathode causes the ejected electrons not to travel far before they again 
strike the inner surface of the cathode, which causes the emission of more electrons. A cascade 
of electrons is then created that finally results in a measurable current at the end of the 
cathode where the anode collects the electrons. The current collected by the anode is 
proportional to the number of secondary particles striking the cathode.

Figure 29. Ion detection system, showing the electron multiplier (top) and conversion dynode 
(bottom)

Typically, the electron multiplier is set to a gain of about 3 × 105 (that is, for each ion or 
electron that enters, 3 × 105 electrons exit) in MS mode and 2 × 106 in MS/MS mode. The 
electrometer circuit converts the current that leaves the electron multiplier via the anode to a 
voltage and the data system records the voltage. 

The ion detection system of the TSQ mass spectrometer increases signal and decreases noise. 
The high voltage applied to the conversion dynode results in a high conversion efficiency and 
increased signal. That is, for each ion striking the conversion dynode, many secondary 
particles are produced. The increase in conversion efficiency is more pronounced for more 
massive ions than it is for less massive ions.

Because of the off-axis orientation of the ion detection system relative to the mass analyzer, 
neutral molecules from the mass analyzer tend not to strike the conversion dynode or electron 
multiplier. As a result, noise from neutral molecules is reduced.

Vacuum System and Inlet Gases Hardware

The vacuum system evacuates the region around the ion source interface, ion optics, mass 
analyzer, and ion detection system. The principal components of the vacuum system include 
the following:

• Vacuum manifold

• Turbomolecular pump
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• Forepump

• Convectron™ gauges

• Ion gauges

The inlet gases hardware controls the flow of collision gas, sheath gas, auxiliary gas, and air 
(during venting) into the mass spectrometer. The inlet gasses hardware includes the following 
components:

• Vent valve

• Collision gas flow control valves

• Sheath gas valve

• Auxiliary gas valve

A functional block diagram of the vacuum system and inlet gasses hardware is shown in 
Figure 30.

Figure 30. Functional block diagram of the vacuum system and inlet gasses hardware
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Vacuum Manifold

The vacuum manifold encloses the ion source interface, ion optics, mass analyzer, and ion 
detection system assemblies. The vacuum manifold is a thick-walled, aluminum chamber with 
two removable side cover plates, with openings on the front, sides, and top, and various 
electrical feedthroughs and gas inlets. 

The vacuum manifold is divided into four chambers by three baffles. See Figure 31. The 
forepump evacuates the region inside the first chamber, called the ion transfer tube/skimmer 
region. The third inlet in the molecular drag section of the triple-inlet turbomolecular 
vacuum pump evacuates the region inside the second chamber, called the Q00 ion optics 
region. The interstage port of the turbomolecular vacuum pump evacuates the region inside 
the third chamber, called the Q0 ion optics region. The high vacuum port of the 
turbomolecular pump evacuates the region inside the fourth chamber, called the analyzer 
region, to less than 10-5 Torr. The turbomolecular pump in turn discharges into the forepump 
through the foreline.

Figure 31. Vacuum manifold (interior)
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The collision cell chamber, inside the analyzer chamber, has a user controlled argon pressure 
of between one and four mTorr when CID is turned on. Argon in the collision cell is 
evacuated by the forepump when CID is turned off.

The vacuum manifold has the following feedthroughs and inlets:

• A feedthrough for the high voltage for the conversion dynode

• A feedthrough for the high voltage for the electron multiplier

• A feedthrough for the ion current signal from the anode of the electron multiplier

• Two feedthroughs for the Q1 quadrupole rf voltage

• Two feedthroughs for the Q3 quadrupole rf voltage

• A feedthrough for the Q2 quadrupole rf voltage

• A feedthrough for lens L21, L22, L23, L31, L32, and L33 voltages

• A feedthrough for lens L0, L11, and L12 voltages

• A feedthrough for the Q00 and Q0 ion optics rf voltages

• A feedthrough for the tube lens offset voltage, ion transfer tube offset voltage, and ion 
transfer tube heater voltages

• A vacuum connection for measuring the pressure in the analyzer region with the ion 
gauge

• An argon gas inlet into the collision cell

• A vent gas inlet

Two removable side cover plates on the left side of the vacuum manifold allow access to the 
Q0 ion optics, mass analyzer, and ion detection system. Two electrically conductive O-rings 
provide a vacuum-tight seal between the side cover plates and the vacuum manifold. 

Turbomolecular Pump

A Leybold TW220/150/15S triple-inlet turbomolecular pump provides the vacuum for the 
Q00 ion optics region, Q0 ion optics region, and analyzer region of the vacuum manifold. 
The turbomolecular pump mounts onto the top of the vacuum manifold (Figure 31). 

The turbomolecular pump has three pumping inlets: 

• A high-vacuum inlet at the top of the rotor stack, which evacuates the analyzer chamber

• An interstage inlet about halfway down the rotor stack, which evacuates the Q0 ion optics 
chamber 

• A third inlet in the molecular drag section of the pump, which evacuates the Q00 ion 
optics chamber
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The turbomolecular pump is controlled by a Leybold TDS controller and powered by a 
+24 V dc (250 W) power supply. The Main Power circuit breaker switch and the Vacuum 
service switch, not the Electronics service switch, turn power for the turbomolecular pump off 
and on. The pump is air cooled by a fan that draws air in from the front of the instrument.

Power to the turbomolecular pump is shut off if the foreline pressure, as measured by the 
Convectron gauge, is too high, or if the turbomolecular temperature is too high. 

Forepump

One (TSQ Quantum Access and TSQ Quantum Access MAX) or two (TSQ Vantage and 
TSQ Quantum Ultra) Edwards™ E2M30 forepumps (or roughing pumps) establish the 
vacuum necessary for the proper operation of the turbomolecular pump. The forepump also 
evacuates the inlet valve and the collision cell. The pump has a maximum displacement of 
650 L/min and maintains a minimum pressure of approximately 1 Pa (0.01 Torr). 

The forepump connects to the turbomolecular pump by a section of reinforced PVC tubing. 
The power cord of the forepump plugs into the outlet labeled Forepump on the power panel 
(see Figure 13 on page 21). This outlet supplies power to the pump and is controlled by the 
Main Power circuit breaker switch and Vacuum service switch, not by the Electronics service 
switch.

Convectron® Gauges

A Convectron gauge measures the pressure in the inlet valve and the foreline, which connects 
the turbomolecular pump and the forepump. The Convectron gauge uses a Wheatstone 
bridge with a temperature dependent resistor to measure pressure down to a fraction of a 
milliTorr. A second Convectron gauge measures the pressure of argon collision gas in the 
collision cell.

Ion Gauges

A Granville-Phillips™ 342™ mini ion gauge measures the pressures in the analyzer region of 
the vacuum manifold. The ion gauge produces energetic electrons that cause the ionization of 
molecules in the ion gauge. Positive ions formed in the ion gauge are attracted to a collector. 
The collector current is related to the pressure in the vacuum manifold. The ion gauge is also 
involved in vacuum protection.

CAUTION  Always plug the forepump power cord into the outlets labeled Forepump on the 
right-side power panel of the mass spectrometer. Never plug it directly into a wall outlet.
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Vent Valve

The vent valve, located in the area of Q2, allows the vacuum manifold to be vented to dry 
nitrogen or filtered air. The vent valve is a solenoid-operated valve, which is controlled by the 
Vent Delay PCB. When the solenoid is energized, the vent valve closes. If the power fails or 
the main power circuit breaker is placed in the Off (O) position, a 4-farad capacitor, which is 
located in the Power Entry Module, keeps the solenoid in the closed position for several 
minutes. If power is not restored in this time, then the solenoid opens and the system is 
vented with dry nitrogen or filtered air. Dry nitrogen (35 kPa [5 psi], maximum, 99% purity) 
enters the mass spectrometer through a 1/4 in. port on the left side of the mass spectrometer. 
See Figure 32. The vent valve closes after power is restored to the mass spectrometer. 

Collision Gas Flow Control Valves

The collision gas flow control valves control the flow of argon collision gas into and out of the 
Q2 collision cell. A solenoid valve acts to shut off argon gas flow to the cell. The collision gas 
pressure is regulated by a proportional valve that is controlled by the data system. You can set 
the collision gas pressure (0 to 5 milliTorr) in the Define Scan dialog box of the EZ Tune 
window. 

Ions enter the Q2 collision cell, collide with the argon collision gas, and then, because of the 
collision, dissociate into smaller fragments. See “Collision Cell and CID Efficiency” on 
page 32.

Argon (135 ± 70 kPa [20 ± 10 psi], 99.995% minimum purity) enters the mass spectrometer 
through a 1/8-in. port on the left side of the mass spectrometer. See Figure 32.

A second proportional valve allows the forepump to evacuate the Q2 collision cell of argon 
and waste gasses when CID is turned off. The TSQ mass spectrometer automatically opens 
and closes the collision gas evacuation valve, depending on whether Q2 is acting as an ion 
transmission device or a collision cell. 

Sheath Gas Valve

The sheath gas valve controls the flow of sheath gas (nitrogen) into the API source. Dry 
nitrogen (690 ± 140 kPa [100 ± 20 psi], 99% purity) enters the mass spectrometer through a 
1/4 in. port on the left side of the mass spectrometer. See Figure 32. A solenoid shutoff valve 
starts and stops the flow of nitrogen to the API source. The data system controls a valve that 
regulates the sheath gas pressure. You can set the sheath gas flow rate (0 to 100 in arbitrary 
units) in the Ion Source dialog box from the EZ Tune window. The sheath gas enters the API 
source through 1/8 in. ID tubing.
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Auxiliary Gas Valve

The auxiliary gas valve controls the flow of auxiliary gas (nitrogen) into the API source. Dry 
nitrogen (690 ± 140 kPa [100 ± 20 psi], 99% purity) enters the mass spectrometer through a 
1/4 in. port on the left side of the mass spectrometer. A solenoid shutoff valve starts and stops 
the flow of nitrogen to the API source. The auxiliary gas pressure is regulated by a flow valve 
that is controlled by the data system. You can set the auxiliary gas flow rate (0 to 60 in 
arbitrary units) in the Ion Source dialog box. The auxiliary gas enters the API source through 
1/8 in. ID tubing.

Figure 32. Nitrogen and argon gas inlets

Electronic Assemblies 

The electronic assemblies that control the operation of the mass spectrometer are distributed 
among various PCBs and other modules located in the tower, in the embedded computer, and 
on or around the vacuum manifold of the mass spectrometer. 

The Power Entry Module provides mass spectrometer power control, a contact closure 
interface, vent valve control, an Ethernet 100 base-T connection from the System Control 
PCB to the data system PC, a mechanical pump failure protection circuit (linked to vent valve 
control), a system reset button, status LEDs, and service ports. The right-side power panel, 
shown in Figure 13 on page 21, is part of the Power Entry Module.

The Power Entry Module accepts line power, filters it, and provides it to various components 
of the mass spectrometer. The Power Module includes the following components:

• Main power circuit breaker switch

• Surge suppressor

• Line filter

• Electronics service switch

• Vacuum service switch

Nitrogen In
690 ± 140 kPa
(100 ± 20 psi)

Nitrogen for Vent
35 kPa MAX
(5 psi MAX)

Argon In
135 ± 70 kPa
(20 ± 10 psi)
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 2 Functional Description
Mass Spectrometer
The “brains” of the TSQ mass spectrometer is the System Control PCB. The System Control 
PCB and embedded computer include the following:

• PowerPC processor

• Serial Peripheral Interconnect (SPI) bus

• I/O coprocessor

• Super Harvard Architecture Computer (Sharc) bus

• Scan generator DSP

• Acquisition processor DSP

• Interbus bridge

• 100 base-T Ethernet port

The rf voltage generation electronic assemblies produce the S-lens (TSQ Vantage only), Q00, 
Q0, Q1, Q2, and Q3 rf voltages that enable ion transmission and mass analysis. The Analyzer 
Control PCB and the System Control PCB control all rf voltages. 

The Q1 and Q3 rf voltage amplifier circuits are identical, and the circuits for Q0 and Q2 are 
similar. 

The rf voltage generation electronic assemblies include the following components: 

• RF oscillator

• RF Voltage Amplifier PCB

• Low Pass Filter PCB

• RF voltage coil

• RF voltage detector

• Mass DAC

• Integrating amplifier

The ion detection system electronic assemblies provide high voltage to the electron multiplier 
and conversion dynode of the ion detection system. They also receive the electron multiplier 
output current signal, convert it to a voltage (by the electrometer circuit), and pass it to the 
embedded computer.

The ion detection system electronic assemblies include the following:

• Electron multiplier power supply

• Conversion dynode power supply

• Electrometer PCB

• Acquisition DSP
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Data System
The Analyzer Control PCB contains circuitry for controlling and monitoring the operation of 
the ion source, ion optics, mass analyzer, and ion detection system. These circuits are in turn 
monitored by the PowerPC processor of the System Control PCB via the SPI bus. 

The Analyzer Control PCB controls and monitors the rf voltages for Q0, Q1, Q2, and Q3 
quadrupoles. It also has lens voltage drivers that convert ±330 V dc power from the DC Rod 
Driver PCB to dc voltages that are applied to the lenses.

Data System
The data system controls and monitors the TSQ mass spectrometer. The data system also 
processes data that the TSQ mass spectrometer acquires. The data system is composed of the 
following:

• Computer Hardware

• Data System / Mass Spectrometer / LC Interface

• Data System / Local Area Network Interface

Computer Hardware

The data system computer has the following major features:

• Intel™ Pentium™ IV processor

• High capacity hard disk drive

• Recordable/rewriteable CD drive

• Primary Ethernet port (data system to mass spectrometer)

• Secondary Ethernet port (data system to local area network)

• High performance video graphics card 

• DVD drive

• 1280×1024 resolution color monitor

• Keyboard and mouse

• Laser printer

For more information about the computer, refer to the appropriate manuals.
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 2 Functional Description
Data System
Data System / Mass Spectrometer / LC Interface 

The data system computer contains a 100 base-T Ethernet adapter (called the primary 
Ethernet adapter) that is dedicated to data system/mass spectrometer/LC communications. 
This primary Ethernet adapter communicates with the mass spectrometer, Accela PDA 
detector, and autosampler via a 10/100 base-T Ethernet switch. The Ethernet adapter on the 
mass spectrometer resides on the System Control PCB. A twisted pair Ethernet cable connects 
the primary Ethernet adapter of the data system with the Ethernet connector on the power 
panel of the mass spectrometer. See Figure 33. The mass spectrometer communicates with the 
Accela LC pump via a USB connection

Data System / Local Area Network Interface 

The data system computer contains a secondary Ethernet adapter. This secondary Ethernet 
adapter is not involved in data system/mass spectrometer or LC communications. You can use 
this secondary Ethernet adapter to access your local area network.

Printer

A high-resolution laser printer communicates with the PC via the local area network. Refer to 
the manual supplied by the manufacturer for details about the printer.

You set up the printer from the Print Setup dialog box. To open the Print Setup dialog box, 
choose File > Print Setup in any window.
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2 Functional Description
Data System
Figure 33. TSQ system interconnect diagram, showing the TSQ mass spectrometer, Accela HPLC, and data system
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3

System Shutdown, Startup, and Reset

Many maintenance procedures for the TSQ system require that the mass spectrometer be shut 
down completely. In addition, you can place the TSQ mass spectrometer in standby mode if 
the system is not to be used for 12 hours or more.

Shutting Down the System in an Emergency
If you need to turn off the mass spectrometer in an emergency, use the following process.

To turn off the LC, autosampler, and computer in an emergency, use the on/off switches on 
the LC, autosampler, and computer, respectively.

Contents

• Shutting Down the System in an Emergency

• Placing the System in Standby Condition

• Shutting Down the System Completely

• Starting Up the System after a Complete Shutdown

• Resetting the Mass Spectrometer

• Resetting the Data System

• Turning Off Selected Mass Spectrometer Components

CAUTION  Place the Main Power circuit breaker switch, located on the power panel on the 
right-side panel of the mass spectrometer, in the Off (O) position. See Figure 34 and 
Figure 35. This turns off all power to the mass spectrometer, including the vacuum 
pumps. Although removing power abruptly will not harm any component within the 
system, under normal conditions do not shut down the system with the main power 
circuit breaker switch. For the recommended procedure, see “Shutting Down the System 
Completely” on page 50. 
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Shutting Down the System in an Emergency
Figure 34. Power panel of the TSQ Vantage or TSQ Quantum Ultra, showing the Main Power 
circuit breaker switch, Electronics service switch, and System Reset button

Figure 35. Power panel of the TSQ Quantum Access, or TSQ Quantum Access MAX, showing the 
Main Power circuit breaker switch, Electronics service switch, Vacuum service switch, 
and System Reset button
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Placing the System in Standby Condition
If you are not going to use the TSQ system for a short period of time, such as overnight or 
over weekends, it does not need to be shut down completely. When you are not going to 
operate the system for 12 hours or more, you can leave the system in standby mode.

To place the TSQ system in standby mode

1. Wait until data acquisition, if any, is complete.

2. Turn off the flow of liquid from the LC (or other sample introduction device) to the 
API source:

a. Choose Start > Programs > Thermo Instruments > TSQ > TSQ Tune to open the 
EZ Tune window.

b. In the EZ Tune window, choose Setup > Inlet Direct Control. The Inlet Direct 
Control view appears.

c. Click the LC tab and click  (Stop) to stop the LC pump.

3. From the EZ Tune window, choose Control > Standby (or click the On/Standby 
button) to put the mass spectrometer in standby. 

When you choose Control > Standby, the TSQ system turns off the electron multiplier, 
conversion dynode, 8 kV power to the API source, and the mass analyzer and ion optics rf 
voltages. The TSQ system also turns off the auxiliary gas and sets the sheath gas flow to 
zero units. See Table 2 on page 58 for the On/Off status of mass spectrometer 
components when the mass spectrometer is in standby mode. The System LED on the 
front panel of the mass spectrometer illuminates yellow when the system is in standby.

4. Flush the ion sweep cone and ion transfer tube of the API source as described in the topic 
“Cleaning the Ion Sweep Cone and Ion Transfer Tube” on page 66. 

5. Leave the mass spectrometer power on.

6. Leave the LC power on.

7. Leave the autosampler power on.

8. Leave the data system power on.

On Off Standby
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Shutting Down the System Completely
Shutting Down the System Completely
Shut down the TSQ system completely if not in use for an extended period only, or if it must 
be shut down for a maintenance or service procedure. For a short period of time, such as 
overnight or over weekends, you can place the system in standby. See “Placing the System in 
Standby Condition.” 

To shut down the TSQ system completely

1. Turn off the flow of liquid from the LC (or other sample introduction device) to the API 
source. To turn off the flow of liquid from the LC to the API source, do the following:

a. Choose Start > Programs > Thermo Instruments > TSQ > TSQ Tune to open the 
EZ Tune window.

b. In the EZ Tune window, choose Setup > Inlet Direct Control. The Inlet Direct 
Control view appears.

c. Click the LC tab and click  (Stop) to stop the LC pump.

2. From the EZ Tune window, choose Control > Off (or click the On/Standby/Off button) 
to turn off the mass spectrometer. 

3. Place the Electronics service switch, located on the power panel (see Figure 34 and 
Figure 35), in the Service Mode position. 

4. On the TSQ Quantum Access or TSQ Quantum Access MAX, place the Vacuum service 
switch, located on the power panel (see Figure 35 on page 48), in the Service Mode 
position. 

5. Place the Main Power circuit breaker switch, located on the power panel (see Figure 34 
and Figure 35) in the Off (O) position. When you place the Main Power circuit breaker 
switch in the Off (O) position, the following occurs:

• All power to the mass spectrometer is turned off. (All LEDs on the front panel of the 
mass spectrometer are off.)

• A capacitor on the Vent Delay PCB provides power to the vent valve for two to four 
minutes (to allow the turbomolecular pump to spin down). After the capacitor 
discharges, power to the vent valve solenoid shuts off. When power to the vent valve 
solenoid shuts off, the vent valve opens and the vacuum manifold is vented to filtered 
air or nitrogen. 

• After about two minutes, the pressure of the vacuum manifold reaches atmospheric 
pressure.

On Off Standby
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 3 System Shutdown, Startup, and Reset
Shutting Down the System Completely
6. Unplug the power cord for the mass spectrometer. 

7. Turn off the (optional) LC. Follow the procedure described in the manual that came with 
the LC.

8. Turn off the argon collision gas supply at the tank. 

9. Turn off the nitrogen supply at the tank.

10. Turn off the data system: 

a. Choose Start > Shut Down from the Windows™ taskbar. The Shut Down Windows 
dialog box appears.

b. To start the Windows shutdown procedure, select Shut down and click OK.

11. Turn off the laser printer by using the on/off switch.

12. Turn off the autosampler by using the Main Power on/off switch.

CAUTION  Allow heated components to cool before servicing them.

Note  If you are planning to perform routine or preventive system maintenance on the 
mass spectrometer only, you do not need to turn off the LC, argon and nitrogen gases, 
data system, or autosampler. In this case, the shutdown procedure is completed. 
However, if you do not plan to operate your system for an extended period of time, 
Thermo Fisher Scientific recommends that you turn off the LC, data system, and 
autosampler as described in the following steps, 7 through 12. 
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Starting Up the System after a Complete Shutdown
To start up the TSQ system after it has been shut down completely, do the following 
procedures:

• Starting Up the LC (optional)

• Starting Up the Data System

• Starting Up the Mass Spectrometer

• Starting Up the Autosampler (optional)

• Setting Up Conditions for Operation

Starting Up the LC

To start up the LC, follow the startup procedure described in the manual that came with the 
LC. If necessary, configure the LC as described in the TSQ Series Getting Connected Guide. Do 
not turn on the liquid flow to the mass spectrometer.

Starting Up the Data System

To start up the data system 

1. Turn on the monitor, computer, and printer.

2. Observe the Windows XP startup procedure on the monitor and press CTRL+ALT+DEL 
when you are prompted to do so. 

3. In the Logon Information dialog box, click OK or enter your password (if you have one).

Starting Up the Mass Spectrometer

To start up the mass spectrometer 

1. Turn on the flows of argon and nitrogen at the tanks if they are off.

2. Make sure that the Main Power circuit breaker switch is in the Off (O) position and that 
the Electronics service switch and the Vacuum service switch (TSQ Quantum Access or 
TSQ Quantum Access MAX) are both in the Service Mode position.

3. Plug in the power cord for the mass spectrometer.

Note  The data system must be running before you start up the mass spectrometer. The 
mass spectrometer will not operate until software is received from the data system.
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Starting Up the System after a Complete Shutdown
4. Place the Main Power circuit breaker switch in the On (|) position. When you place the 
Main Power circuit breaker switch in the On (|) position, power is supplied to those mass 
spectrometer components that are not affected by the Vacuum service switch and the 
Electronics service switch.

5. On the TSQ Quantum Access or TSQ Quantum Access MAX, place the Vacuum service 
switch in the Operational position.

6. Place the Electronics service switch in the Operational position. When you place the 
Electronics service switch in the Operational position, the following occurs:

• The Power LED on the mass spectrometer front panel illuminates green to indicate 
that power is provided to the mass spectrometer electronics. (The electron multiplier, 
conversion dynode, ion source, and mass analyzer and ion optics rf voltages 
remain off.)

• The embedded computer reboots. After several seconds the Communication LED on 
the front panel illuminates yellow to indicate that the data system and the mass 
spectrometer have started to establish a communication link.

• After several more seconds, the Communication LED illuminates green to indicate 
that the data system and the mass spectrometer have established a communication 
link. Software for the operation of the mass spectrometer is then transferred from the 
data system to the mass spectrometer.

• After three minutes, the System LED illuminates yellow to indicate that the software 
transfer from the data system to the mass spectrometer is complete and that the 
instrument is in standby.

• The Vacuum LED on the front panel of the mass spectrometer remains off until the 
turbomolecular pump reaches 80 percent of its operational speed of 750 Hz. At this 
time the ion gauge is turned on and the Vacuum LED illuminates yellow. The 
Vacuum LED illuminates green, and the high voltage can be turned on, only if the 
pressure in the mass analyzer region, as measured by the ion gauge, is below the 
maximum allowable pressure of 7 × 10-4 Torr. 

If you have an autosampler, go to the next topic, “Starting Up the Autosampler.” If you do not 
have an autosampler, go to the topic “Setting Up Conditions for Operation.” 

Starting Up the Autosampler

To start up the autosampler

Place the main power switch on the autosampler in the on position. If necessary, 
configure the autosampler. For procedures for placing sample vials, preparing solvent and 
waste bottles, installing syringes, and so on, refer to the manual that came with the 
autosampler. Refer also to the TSQ Series Getting Connected Guide.
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Setting Up Conditions for Operation

To set up your TSQ mass spectrometer for operation

1. Before you begin data acquisition with your TSQ system, allow the system to pump down 
for at least one hour. Operation of the system with excessive air and water in the vacuum 
manifold can cause reduced sensitivity, tuning problems, and reduced lifetime of the 
electron multiplier.

2. Ensure that the argon pressure and nitrogen pressure are within the operational limits 
[argon: 135 ±70 kPa (20 ±10 psig), nitrogen: 690 ±140 kPa (100 ±20 psig)]. 

3. In the EZ Tune window, choose View > Instrument Status and look at the Instrument 
Status view. Check that the ion gauge pressure is below about 5 × 10-6 Torr, and that the 
forepump pressure is below about 50 mTorr (with the ion transfer tube sealed with a 
septum cap). 

4. Remove the septum cap from the orifice of the ion transfer tube.

5. Set up the API source for operation as described in the Ion Max and Ion Max-S API Source 
Hardware Manual, HESI-II Probe User Guide, H-ESI Probe User Guide, Nanospray Ion 
Source Operator’s Manual, and TSQ Series Getting Started Guide. 

Note  Air in the argon line must be purged or given sufficient time to be purged for 
normal TSQ mass spectrometer performance.

Note  You do not need to calibrate and tune the TSQ mass spectrometer each time 
you restart the TSQ system. 

Calibration parameters are instrument parameters that affect the mass accuracy and 
resolution. Tune parameters are instrument parameters that affect the intensity of the 
ion signal. You must tune and calibrate the TSQ mass spectrometer (that is, optimize 
the tune and calibration parameters) perhaps once a quarter. Refer to “Automatic 
Tuning and Calibrating in the ESI/MS Mode” in the TSQ Series Getting Started Guide 
for a procedure for tuning and calibrating the TSQ mass spectrometer. 

You must optimize the tune parameters (or change the Tune Method) whenever you 
change the type of experiment. For procedures on how to optimize the tune 
parameters for an ESI or APCI experiment, refer to “Optimizing the Mass 
Spectrometer with Your Compound in ESI/MS/MS Mode” or “Optimizing the 
Mass Spectrometer with Your Compound in APCI/MS/MS Mode” in the TSQ Series 
Getting Started Guide. 
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Resetting the Mass Spectrometer
If communication between the mass spectrometer and data system computer is lost, it might 
be necessary to reset the mass spectrometer using the System Reset button on the right-side 
power panel. Pressing the System Reset button creates an interrupt in the embedded 
computer. This causes the embedded computer to restart in a known (default) state. See 
Figure 34 on page 48 for the location of the System Reset button.

The procedure given here assumes that the mass spectrometer and data system computer are 
both powered on and operational. If the mass spectrometer, data system computer, or both are 
off, go to “Starting Up the System after a Complete Shutdown” on page 52.

To reset the mass spectrometer

Press the System Reset button located on the right-side power panel. Make sure the 
Communication LED is extinguished before releasing the System Reset button. When you 
press the Reset button, the following occurs:

• An interrupt on the embedded computer causes the CPU to reboot. All LEDs on the 
front panel of the mass spectrometer are off except the Power LED.

• After several seconds, the Communication LED illuminates yellow to indicate that the 
data system and the mass spectrometer are starting to establish a communication link.

• After several more seconds, the Communication LED illuminates green to indicate that 
the data system and the mass spectrometer have established a communication link. 
Software for the operation of the mass spectrometer is then transferred from the data 
system to the mass spectrometer.

• After three minutes the software transfer is complete. The System LED illuminates either 
green to indicate that the instrument is functional and the high voltages are on, or yellow 
to indicate that the instrument is functional and is in standby.

Resetting the Data System
There are two ways to reset the data system: 

• Resetting the Data System by Using the Windows Shutdown and Restart Procedure

• Resetting the Data System by Turning the Personal Computer Off Then On
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Resetting the Data System by Using the Windows Shutdown and Restart Procedure

If possible, use the Windows shutdown and restart procedure to shut down and restart the 
data system so that Windows can properly close programs and save changes to files.

To reset the data system by using the Windows shutdown and restart procedure

1. Choose Start > Shut Down from the Windows taskbar. The Shut Down Windows dialog 
box appears.

2. To start the Windows shutdown and restart procedure, select Restart and click OK.

3. Observe the Windows shutdown and restart procedure on the monitor. Press 
CTRL+ALT+DELETE when you are prompted to do so. 

4. To complete the shutdown and restart procedure, click OK or enter your password (if you 
have one) in the Logon Information dialog box.

Resetting the Data System by Turning the Personal Computer Off Then On

If you are unable to reset the data system by using the Windows shutdown and restart 
procedure, proceed as follows:

1. Press the Power button on the personal computer to turn the personal computer off.

2. After several seconds, press the Power button on the personal computer to turn the 
personal computer on.

3. Observe the Windows XP startup procedure on the monitor and press 
CTRL+ALT+DELETE when you are prompted to do so. 

4. To complete the shutdown and restart procedure, click OK or enter your password in the 
Logon Information dialog box.

5. When the shutdown and restart procedure has completed, choose Start > All Programs > 
Thermo Instruments > TSQ > TSQ Tune to display the EZ Tune window. 

Note  The communications link between the data system and the mass spectrometer 
should automatically reestablish after you reset the data system. When this occurs the 
Communication LED on the front panel of the mass spectrometer illuminates yellow and 
then green. If the system is unable to reestablish the communications link, press the 
System Reset button on the power panel of the mass spectrometer. 

Note  The communications link between the data system and the mass spectrometer 
should automatically reestablish after you reset the data system. When this occurs the 
Communication LED on the front panel of the mass spectrometer illuminates yellow and 
then green. If the system is unable to reestablish the communications link, press the 
System Reset button on the right-side power panel of the Power Entry Module of the mass 
spectrometer.
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Turning Off Selected Mass Spectrometer Components
There are different ways that you can turn off some or all of the mass spectrometer 
components:

• Turn off individual mass spectrometer components from the EZ Tune window. Turning 
off individual mass spectrometer components might be necessary when you are 
troubleshooting or when you are running certain diagnostic procedures.

• Place the mass spectrometer in standby mode. Standby is the normal condition to leave 
the mass spectrometer in when it is not in use. Choose Control > Standby (or turn the 
On/Standby button on or off ) from the EZ Tune window to place the mass spectrometer 
in standby.

• Place the mass spectrometer in the off condition. The off condition is similar to standby, 
except all high voltage components of the mass spectrometer are turned off. Choose 
Control > Off from the EZ Tune window to place the mass spectrometer in the off 
condition.

• Place the Electronics service switch in the Service Mode position. The Electronics service 
switch turns off all components in the mass spectrometer other than the +24 V power 
supply, forepump, turbomolecular pump, Vent Delay PCB, and fans.

• Place the Vacuum service switch on the TSQ Quantum Access or TSQ Quantum Access 
MAX in the Service Mode position. The Vacuum service switch turns off all vacuum 
system components, including the +24 V power supply, forepump, turbomolecular 
pump, Vent Delay PCB, and fans.

• Place the Main Power circuit breaker switch in the Off (O) position. Placing the Main 
Power circuit breaker switch in the Off (O) position removes all power to the mass 
spectrometer, including the vacuum system.
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Table 2 summarizes the on/off status of mass spectrometer components, voltages, and gas 
flows.

Table 2. On/Off status of mass spectrometer components, voltages, and gas flows (Sheet 1 of 2)

Mass spectrometer component

Standby Off
Electronics 
service 
switch in 
Service Mode 
position

Vacuum service 
switch (TSQ 
Quantum Access 
or Access MAX) 
in Service Mode 
position

MS Main Power 
circuit breaker 
switch in Off 
position

Electron multiplier Off Off Off Off Off

Conversion dynode Off Off Off Off Off

Mass analyzer rf voltage Off Off Off Off Off

Mass analyzer dc offset voltage Off Off Off Off Off

Q00 and Q0 ion optics rf voltage Off Off Off Off Off

Q00 and Q0 ion optics dc offset 
voltage

Off Off Off Off Off

Tube lens or S-lens On Off Off Off Off

Ion transfer tube heater On Off Off Off Off

Ion transfer tube dc offset On Off Off Off Off

APCI corona discharge needle Off Off Off Off Off

APCI vaporizer Off Off Off Off Off

ESI needle Off Off Off Off Off

Sheath gas Off Off Off Off Off

Auxiliary gas Off Off Off Off Off

Argon collision gas Off Off Off Off Off

Vent valve Closed Closed Closed Open 
(after 2 to 4 min)

Open 
(after 2 to 4 min)

Turbomolecular pump On On On Off Off

Forepump On On On Off Off

Vent Delay PCB On On On Off Off 

Embedded computer On On Off On Off

Turbomolecular pump controller On On On Off Off

Power supply, electron multiplier, 
and conversion dynode

Off Off Off Off Off

Power supply, 8 kV Off Off Off Off Off

PS1 power supply, +24 V On On On Off Off
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PS2 power supply, +5, ±15, 
±24 V dc 

On On Off Off Off

PS3 power supply, +36, –28 V dc On On Off Off Off

Fan, turbomolecular pump On On On Off Off

Fan, above manifold On On On Off Off

Fan, center wall On On On Off Off

Convectron gauge, foreline On On On On Off

Convectron gauge, collision cell On On Off On Off

Ion gauge On On Off Off Off

Table 2. On/Off status of mass spectrometer components, voltages, and gas flows (Sheet 2 of 2)

Mass spectrometer component

Standby Off
Electronics 
service 
switch in 
Service Mode 
position

Vacuum service 
switch (TSQ 
Quantum Access 
or Access MAX) 
in Service Mode 
position

MS Main Power 
circuit breaker 
switch in Off 
position
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Daily Operation

To ensure the proper operation of your system, Thermo Fisher Scientific recommends daily 
performance of these checks and cleaning procedures for the TSQ system.

Things to Do Before Operating the TSQ System
Every day before starting analyses, verify that the instrument is ready for operation by doing 
the following:

• Check the argon and nitrogen supplies.

• Check the ESI fused-silica sample tube for elongation.

• Check the system vacuum levels.

Contents

• Things to Do Before Operating the TSQ System

• Things to Do After Operating the TSQ System

Note  You do not need to tune and calibrate the mass spectrometer as part of your daily 
routine. 

Tune parameters are instrument parameters that affect the intensity of the ion signal. 
Calibration parameters are instrument parameters that affect the mass accuracy and 
resolution of the mass spectrum. You must tune and calibrate the mass spectrometer (that 
is, optimize the tune and calibration parameters) perhaps once a quarter. For procedures 
on how to tune and calibrate your mass spectrometer, refer to “Automatic Tuning and 
Calibrating in the ESI/MS Mode” in the TSQ Series Getting Started Guide. 

You must optimize the tune parameters (or change the Tune Method) whenever you 
change the type of experiment. For procedures on how to optimize the tune parameters 
for your ESI or APCI experiment, refer to “Optimizing the Mass Spectrometer with 
Your Compound in ESI/MS/MS Mode” or “Optimizing the Mass Spectrometer 
with Your Compound in APCI/MS/MS Mode” in the TSQ Series Getting Started Guide. 
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Checking the Argon and Nitrogen Supplies

Check the argon supply on the regulator of the gas tank. Make sure that you have sufficient 
gas for your analysis. If necessary, install a new tank of argon. Verify that the pressure of argon 
reaching the mass spectrometer is between 135 ± 70 kPa (20 ± 10 psig). If necessary, adjust 
the pressure with the tank pressure regulator.

Check the nitrogen supply on the regulator of the nitrogen gas tank or liquid nitrogen boil-off 
tank. Make sure that you have sufficient gas for your analysis. Based on 24-hour per day 
operation, typical nitrogen consumption is 2800 liters per day (100 cubic feet per day). If 
necessary, replace the tank. Verify that the pressure of nitrogen reaching the mass spectrometer 
is between 690 ± 140 kPa (100 ± 20 psig). If necessary, adjust the pressure with the tank 
pressure regulator. 

Checking the ESI Fused-Silica Sample Tube for Elongation

Using acetonitrile in the mobile phase can cause elongation of the polyimide coating on the 
fused-silica sample tube. Elongation of the polyimide coating can degrade signal intensity and 
signal stability over time. 

If you are running in ESI mode with a fused-silica sample tube, verify the sample tube is not 
elongated past the tip of the ESI spray needle. (This elongation does not occur with a metal 
needle.)

To cut and reposition the sample tube approximately 0.5 mm (between 0 and 1 mm) inside 
the end of the ESI needle, refer to the Ion Max and Ion Max-S API Source Hardware Manual 
for more information.

Checking the System Vacuum Levels

For proper performance, your TSQ system must operate at the proper vacuum levels. 
Operation of the system with poor vacuum levels can cause reduced sensitivity, tuning 
problems, and reduced lifetime of the electron multiplier. You should check your system for 
air leaks by checking the system vacuum levels before you begin your first acquisition.

You can check the current values of the pressures in the ion transfer tube-skimmer region and 
foreline (labeled Forepump Pressure) and in the analyzer region (labeled Ion Gauge Pressure) in 
the Instrument Status view of the EZ Tune window. To display the EZ Tune window, from 
the Windows taskbar choose Start > All Programs > Thermo Instruments > TSQ > 
TSQ Tune. Choose View > Instrument Status to display the Instrument Status view.

CAUTION  Before you begin normal operation each day, ensure that you have sufficient 
nitrogen for your API source. The presence of oxygen in the ion source when the mass 
spectrometer is on could be unsafe. The TSQ system displays a pop-up message if the 
nitrogen pressure is too low. 
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Compare the current values of the pressures in the vacuum manifold with the values listed in 
Table 3. If the current values are higher than normal, you might have an air leak. 

If the pressure is high (above 5 × 10-5 Torr in the analyzer region), and you have restarted the 
system within the last 30 to 60 minutes, wait an additional 30 minutes and recheck the 
pressure. If the pressure is decreasing with time, check the pressure periodically until it is 
within the typical pressure range of the mass spectrometer.

If the pressure remains high, your system might have an air leak. If you suspect an air leak, 
shut down the system as described in the topic “Shutting Down the System Completely” on 
page 50. Make a visual inspection of the vacuum system and vacuum lines for leaks. Check 
each fitting and flange on the system for tightness, and tighten the fittings or flanges that are 
loose. Do not tighten fittings indiscriminately. Pay particular attention to fittings that have 
been changed recently or to fittings that have been subjected to heating and cooling. Make 
sure that the cover plates of the vacuum manifold are properly seated.

Table 3. Typical pressure readings for TSQ Vantage and TSQ Quantum Ultra

Conditions Convectron gauge reading (foreline, 
ion transfer tube- skimmer region)

Ion gauge reading 
(analyzer region)

Collision gas off, ion transfer 
tube orifice sealed

less than 0.05 Torr Less than 
3 × 10-6 Torr (after 
pumping for at least 
one hour)

Collision gas off, ion transfer 
tube orifice open

0.9 to 1.2 Torr (110 V at 60 Hz) 
1.5 to 2.2 Torr (220 V at 50 Hz)

Less than 
5 × 10-6 Torr

Collision gas set to 2 mTorr, ion 
transfer tube orifice open

0.9 to 1.2 Torr (110 V at 60 Hz) 
1.5 to 2.2 Torr (220 V at 50 Hz)

Less than 
3 × 10-5 Torr

Table 4. Typical pressure readings for TSQ Quantum Access and TSQ Quantum Access MAX

Conditions Convectron gauge reading (foreline, 
ion transfer tube- skimmer region)

Ion gauge reading 
(analyzer region)

Collision gas off, ion transfer 
tube orifice sealed

less than 0.05 Torr Less than 
3 × 10-6 Torr (after 
pumping for at least 
one hour)

Collision gas off, ion transfer 
tube orifice open 

1.2 to 1.8 Torr (110 V at 60 Hz) 
1.5 to 2.2 Torr (220 V at 50 Hz)

Less than 
5 × 10-6 Torr 

Collision gas set to 2 mTorr, ion 
transfer tube orifice open 

1.2 to 1.8 Torr (110 V at 60 Hz) 
1.5 to 2.2 Torr (220 V at 50 Hz)

Less than 
3 × 10-5 Torr 
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Things to Do After Operating the TSQ System
After operating the TSQ system, verify the instrument is ready for a period of inactivity by 
doing the following:

• Flushing the Sample Transfer Line, Sample Tube, and API Probe 

• Placing the System in Standby Condition

• Cleaning the Ion Sweep Cone and Ion Transfer Tube

• Emptying the Solvent Waste Bottle

Flushing the Sample Transfer Line, Sample Tube, and API Probe

Thermo Fisher Scientific recommends flushing the sample transfer line, sample tube, and API 
probe at the end of each working day (or more often if you suspect they are contaminated) by 
flowing a 50:50 methanol/distilled water solution from the LC through the API source.

To flush the sample transfer line, sample tube, and API probe

1. Wait until data acquisition, if any, is complete.

2. To display the EZ Tune window, from the Windows taskbar choose Start > Programs > 
Thermo Instruments > TSQ > TSQ Tune.

3. From the EZ Tune window, choose Control > On (or click the On/Standby button) to 
turn on the voltages and gas flows to the API source. 

• If you are operating in APCI mode, go to step 4.

• If you are operating in ESI mode, go to step 5.

4. Set up the APCI source:

a. In the EZ Tune window, click on the Ion Source button to display the Ion Source 
Devices dialog box. 

b. Set the APCI vaporizer temperature to 500 °C:
Select Vaporizer Temperature in the device list, and then type 500 in the box and 
click Apply.

c. Set the sheath gas flow rate to 30:
Select Sheath Gas Pressure in the device list, and then type 30 in the box and click 
Apply. 

d. Set the auxiliary gas flow rate to 5:
Select Aux Valve Flow in the device list, and then type 5 in the box and click Apply.

e. Set the spray current to 0:
Select Spray Current in the device list, and then type 0 in the box and click Apply. 

Go to step 6.
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5. Set up the ESI source as follows:

a. In the EZ Tune window, click on the Ion Source button to display the Ion Source 
Devices dialog box. 

b. Set the sheath gas flow rate to 30:
Select Sheath Gas Pressure in the device list, and then type 30 in the box and click 
Apply. 

c. Set the auxiliary gas flow rate to 5:
Select Aux Valve Flow in the device list, and then type 5 in the box and click Apply. 

d. Set the ESI spray voltage to 0:
Select Spray Voltage in the device list, and then type 0 in the box and click Apply. 

6. Set up and start a flow of 50:50 methanol/water solution from the LC to the API source, 
as follows:

a. In the EZ Tune window, choose Setup > Inlet Direct Control. The Inlet Direct 
Control view appears.

b. Click the LC tab.

c. Set the flow rate to a value that is typical for your experiments.

d. Set the solvent proportions to 50% methanol and water.

e. Click  (Start) to start the LC pump.

7. Let the solution flow through the sample transfer line, sample tube, and API probe for 
15 minutes. After 15 minutes, turn off the flow of liquid from the LC to the API source, 
as follows: Leave the API source (including the APCI vaporizer, sheath gas, and auxiliary 
gas) on for an additional 5 minutes. Click  (Stop) to stop the LC pump.

8. After 5 minutes, turn off the API source by placing the mass spectrometer in standby: 
From the EZ Tune window, choose Control > Standby (or click the On/Standby button) 
to put the mass spectrometer in standby.

Go to the next topic, “Placing the System in Standby Condition.” 

Placing the System in Standby Condition

To place the TSQ system in standby condition

1. From the EZ Tune window, choose Control > Standby (or click the On/Standby button) 
to put the mass spectrometer in standby. The System LED on the front panel of the mass 
spectrometer is illuminated yellow when the system is in standby.

2. Leave the mass spectrometer power on.

3. Leave the LC power on.

4. Leave the autosampler power on.
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5. Leave the data system power on.

Go to the next topic, “Cleaning the Ion Sweep Cone and Ion Transfer Tube.” 

Cleaning the Ion Sweep Cone and Ion Transfer Tube

You must clean the ion sweep cone and the ion transfer tube on a regular basis to prevent 
corrosion and to maintain optimum performance of your API source. If you use nonvolatile 
buffers in your solvent system or high concentrations of sample, you might need to clean the 
ion sweep cone and ion transfer tube more often.

See the topic, “Maintaining the Ion Sweep Cone and Ion Transfer Tube” on page 77.

Go to the next topic, “Emptying the Solvent Waste Bottle.” 

Emptying the Solvent Waste Bottle

Thermo Fisher Scientific recommends checking the solvent level in the solvent waste bottle 
on a daily basis. If necessary, empty the solvent waste bottle. Dispose of the solvent waste in 
accordance with local and federal regulations.
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Removing and Reinstalling the Ion Source Housing

You must remove the Ion Max™ (on the TSQ Quantum Access MAX, TSQ Vantage, or 
TSQ Quantum Ultra) or Ion Max-S (on the TSQ Quantum Access) ion source housing 
before performing maintenance on the ion optics or ion source interface, or to access the ion 
sweep cone. 

Removing the Ion Max or Ion Max-S Ion Source Housing 

To remove the ion source housing 

1. Remove the drain tube from the ion source housing drain. See Figure 36 and Figure 37.

2. Rotate the ion source housing locking levers 90 degrees to release the ion source housing 
from the ion source mount assembly.

3. Remove the ion source housing by pulling it straight off the ion source mount assembly, 
and place the housing in a safe location for temporary storage.

Contents

• Removing the Ion Max or Ion Max-S Ion Source Housing

• Installing the Ion Max or Ion Max-S Ion Source Housing

• Ion Max and Ion Max-S Housing Maintenance

Note  If an ion source probe is still installed in the ion source housing, disconnect the 
external liquid lines to the probe before removing the ion source housing.
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Removing the Ion Max or Ion Max-S Ion Source Housing
Figure 36. Ion Max source housing (front)

Figure 37. Ion Max-S source housing (front)

Ion source housing 
locking lever (2x) 

Ion source housing drain

Ion source housing 
locking levers

Ion source housing 
drain
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Installing the Ion Max or Ion Max-S Ion Source Housing
To reinstall the Ion Max or Ion Max-S ion source housing 

1. Align the two guide pin holes on the rear of the ion source housing with the ion source 
housing guide pins on the mass spectrometer. Carefully press the ion source housing onto 
the ion source mount. See Figure 38 and Figure 39.

Figure 38. Ion source housing (rear)

Ion source housing 
locking levers

Guide pin holes
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Figure 39. Ion source mount, showing the ion source housing guide pins and ion source 
interface release lever

2. Rotate the ion source housing locking levers 90 degrees to lock the ion source housing 
onto the ion source mount assembly.

3. Reinstall the ion source housing drain tube: 

a. Connect the 1 in. ID Tygon™ tubing (P/N 00301-22922) to the ion source housing 
drain fitting.

Ion source housing 
guide pins

Ion source 
interface 
release lever

CAUTION  Prevent solvent waste from backing up into the ion source and mass 
spectrometer. Always ensure that liquid in the drain tube is able to drain to a waste 
container.

CAUTION  Do not vent the ion source drain tube (or any vent tubing connected to 
the waste container) to the same fume exhaust system to which you have connected 
the forepump. The ion source chamber and analyzer optics can become contaminated 
with mechanical pump oil if the ion source drain tube and the (blue) forepump 
exhaust tubing are connected to the same fume exhaust system.

Your laboratory must be equipped with at least two fume exhaust systems. Route the 
(blue) forepump exhaust tubing to a dedicated fume exhaust system. Route the drain 
tube from the ion source to a waste container. Vent the waste container to a dedicated 
fume exhaust system.
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b. Attach the free end of the hose to a dedicated drain system. Vent the drain system to 
a fume exhaust system.

The Ion Max or Ion Max-S ion source is now properly installed on the mass spectrometer.

Ion Max and Ion Max-S Housing Maintenance
The Ion Max and Ion Max-S ion source housings are designed to be serviced by 
Thermo Fisher Scientific customer support engineers. User maintenance is limited to cleaning 
the ion source housing as necessary. To clean the housing, remove the housing from the 
instrument, and in an appropriate fume hood rinse the interior of the housing with methanol. 
Allow the housing to dry before you install it on the mass spectrometer. Be sure to follow all 
safety precautions in the sections regarding the installation and removal of the housing. For 
any additional service that might be required, contact your local Thermo Fisher Scientific 
service representative.
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Maintenance

This chapter describes routine maintenance procedures that you must perform to ensure 
optimum performance of the instrument. Optimum performance of the TSQ mass 
spectrometer depends on the maintenance of all parts of the instrument. You are responsible 
for maintaining your system properly by performing the system maintenance procedures 
on a regular basis.

Table 5 lists routine and infrequent mass spectrometer maintenance procedures. Most of the 
procedures involve cleaning. For example, procedures are provided for cleaning the ion 
transfer tube, the ion sweep cone, the skimmer and tube lens of the TSQ Quantum Access, 
TSQ Quantum Access MAX, or TSQ Quantum Ultra, the exit lens and S-lens of the 
TSQ Vantage, the Q00 rf lens, the lens L0, and the fan filters. Procedures for replacing the 
ion transfer tube and the capillary heater assembly are also provided. For instructions on 
maintaining the LC or autosampler, refer to the manual that comes with the LC or 
autosampler. 

Note  When you perform maintenance procedures, be methodical; always wear clean, 
lint-free gloves when handling the components of the ion source; always place the 
components on a clean, lint-free surface; and never overtighten a screw or use excessive 
force.

Contents

• Frequency of Cleaning

• Maintaining the Ion Sweep Cone and Ion Transfer Tube

• Maintaining the Ion Source Interface Assembly

• Cleaning the Q00 Ion Optics

• Cleaning the Fan Filters
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Table 5. Mass spectrometer maintenance procedures (Sheet 1 of 2)

Mass spectrometer component Procedure Frequency Procedure location

API source Flush (clean) sample transfer 
line, sample tube, and API 
probe

Daily page 64

Remove and clean ion 
transfer tube

Weekly, or if ion transfer 
tube bore is contaminated 
or obstructed

page 77

Remove and clean ion sweep 
cone

As needed* page 77

Clean Ion Max or Ion Max-S 
housing

As needed* page 71

Replace ion transfer tube If ion transfer tube bore is 
corroded 

page 77

Q00 ion optics Clean S-lens and exit lens 
(TSQ Vantage)

As needed* page 85

Clean tube lens and skimmer 
(TSQ Quantum Access, 
TSQ Quantum Access MAX, 
and TSQ Quantum Ultra)

As needed* page 86

Clean Q00 rf lens and 
lens L0

Every 3 to 4 months* page 95

APCI, ESI, or H-ESI probe Replace fused-silica sample 
tube

If sample tube is broken or 
obstructed

Ion Max and Ion Max-S 
API Source Hardware 
Manual or H-ESI Probe 
User Guide

ESI or H-ESI probe Trim fused-silica sample tube If polyimide coating on the 
end of the sample tube has 
elongated

Ion Max and Ion Max-S 
API Source Hardware 
Manual or H-ESI Probe 
User Guide

HESI-II probe Replace needle insert If metal needle is plugged HESI-II Probe User 
Guide

Forepump Purge (decontaminate) oil If the oil is cloudy or 
discolored

Manufacturer’s 
documentation

Add oil If the oil level is below the 
MIN mark

Manufacturer’s 
documentation

Change oil Every four months, or if oil 
remains cloudy or 
discolored after purging

Manufacturer’s 
documentation
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Frequency of Cleaning

The frequency of cleaning the components of the mass spectrometer depends on the types and 
amounts of samples and solvents that are introduced into the instrument. In general, for a 
given sample and ionization technique, the closer a mass spectrometer component is to the 
source of the ions, the more rapidly it becomes dirty.

• Clean the sample transfer line, sample tube, and API probe at the end of each operating 
day to remove any residual salts from buffered mobile phases or other contamination that 
might accumulate during normal operation. See “Flushing the Sample Transfer Line, 
Sample Tube, and API Probe” on page 64.

• Periodically remove and clean the ion transfer tube and ion sweep cone of the API source. 
See “Maintaining the Ion Sweep Cone and Ion Transfer Tube” on page 77.

• The S-lens and exit lens (on the TSQ Vantage) or the tube lens and skimmer (on the 
TSQ Quantum Access, TSQ Quantum Access MAX, and TSQ Quantum Ultra) of the 
Q00 ion optics become dirty at a slower rate than the API probe, ion sweep cone, and ion 
transfer tube. See “Cleaning the S-Lens and Exit Lens (TSQ Vantage)” on page 85.

• The rf lens of the Q00 ion optics becomes dirty at a rate significantly slower than the 
API source, tube lens and skimmer, or S-lens and exit lens. See “Cleaning the Q00 Ion 
Optics” on page 89. 

Q0 ion optics Clean Q0 quadrupole and 
lenses L11 and L12**

As needed*

Mass analyzer Clean Q1, Q2, and Q3 
quadrupoles and lenses**

As needed*

Ion detection system Clean ion detection system 
(electron multiplier and 
conversion dynode)**

Whenever the side cover 
plate of the vacuum 
manifold is removed

Cooling fans Clean fan filters Every 4 months page 99

Ion detection system Replace electron multiplier 
assembly**

If noise in spectrum is 
excessive or proper electron 
multiplier gain can not be 
achieved

Electronic modules Replace electronic module** If electronic module fails

PCBs Replace PCB** If PCB fails
* The frequency of cleaning the components of the mass spectrometer depends on the types and amounts of samples and solvents that are 

introduced into the instrument. Cleaning of the Q0, Q1, Q2, and Q3 quadrupoles is rarely (if ever) required.
** A Thermo Fisher Scientific field service engineer should perform this maintenance procedure.

Table 5. Mass spectrometer maintenance procedures (Sheet 2 of 2)

Mass spectrometer component Procedure Frequency Procedure location
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When the performance of your system decreases significantly due to contamination, clean the 
components of the mass spectrometer in the following order:

• Clean the API probe, ion sweep cone, and ion transfer tube.

• Clean the S-lens and exit lens (on the TSQ Vantage) or the tube lens and skimmer (on the 
TSQ Quantum Access, TSQ Quantum Access MAX, and TSQ Quantum Ultra).

• Clean the Q00 rf lens and lens L0. 

Generally, do not open the vacuum manifold. Cleaning the Q0, Q1, Q2, and Q3 
quadrupoles is rarely (if ever) required. (Q0 can be removed and cleaned along with Q00.) If 
you believe that the Q1, Q2, or Q3 quadrupoles need cleaning, contact Thermo Fisher 
Scientific and schedule a visit by a Thermo Fisher Scientific field service engineer. 

If you open the vacuum manifold, clean the electron multiplier and conversion dynode by 
blowing them with a clean, dry gas. If you do not open the vacuum manifold, the electron 
multiplier and conversion dynode do not normally require cleaning, although rarely the 
electron multiplier might require replacement. 

CAUTION  As with all chemicals, store and handle solvents and reagents according to 
standard safety procedures. Dispose of them according to local and federal regulations. 
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Maintaining the Ion Sweep Cone and Ion Transfer Tube 
To prevent corrosion and to maintain optimum performance of the API source, remove and 
clean the ion sweep cone and the ion transfer tube on a regular basis. 

Removing and Cleaning the Ion Transfer Tube

Buffer salts or high concentrations of sample can block the bore of the ion transfer tube. You 
can easily remove the ion transfer tube for cleaning, however, as it does not require venting the 
system before removal.

If the pressure in the ion transfer tube-skimmer region (as measured by the Convectron gauge) 
drops considerably below 1 Torr, a blocked ion transfer tube could be the cause. Check the 
Convectron gauge pressure by choosing View > Instrument Status from the EZ Tune 
window. The pressure is listed under Forepump Pressure.

To remove and clean the ion transfer tube

1. Place the instrument in standby: 

a. Choose Start > Programs > Thermo Instruments > TSQ > TSQ Tune to open the 
EZ Tune window.

b. From the EZ Tune window, choose Control > Standby (or click the On/Standby 
button) to put the mass spectrometer in Standby mode. 

2. Turn off the flow of liquid from the LC (or other sample introduction device) to the 
API source: 

a. In the EZ Tune window, choose Setup > Inlet Direct Control. The Inlet Direct 
Control dialog box appears.

b. Click the LC tab and click  (Stop) to stop the LC pump.

3. Lower the temperature of the ion transfer tube (capillary): 

a. In the EZ Tune window, click  to open the Ion Source Devices dialog box. 
See Figure 40.

On Off Standby

CAUTION  Lower the temperature of the ion transfer tube to 50 °C or less before you 
remove it. Handling a hot ion transfer tube or ion sweep cone can cause burns. 

CAUTION  Attempting to remove a hot ion transfer tube might cause it to bind and 
break in the heater assembly or strip the threads of the ion source interface. 
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Figure 40. Ion Source Devices dialog box showing the ion transfer tube (capillary) at 270 °C

b. Click Capillary Temperature in the Device list.

c. Set the ion transfer tube (capillary) temperature to 50 °C or lower in the Capillary 
Temperature box and click Apply. 

d. Allow the ion transfer tube (capillary) to cool to 50 °C or lower. See Figure 41.

Figure 41. Ion Source Devices dialog box showing the ion transfer tube (capillary) at 50 °C
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4. Remove the Ion Max or Ion Max-S ion source housing from the front of the mass 
spectrometer. See “Removing the Ion Max or Ion Max-S Ion Source Housing” on 
page 67. 

5. Remove the ion sweep cone by pulling it off the ion source interface.

6. With the custom removal tool from the accessory kit (P/N 70111-20258), remove the 
ion transfer tube by turning it counterclockwise until you can pull it free from the ion 
source interface. See Figure 42.

Figure 42. Removal tool attached to the ion transfer tube

Figure 43. Spray cone, ion transfer tube, O-ring, and ion sweep cone of the ion source 
interface

7. Soak the ion transfer tube in a dilute solution of nitric acid to remove contaminants.

Ion transfer tube

Vespel O-ring

Spray cone

Ion sweep cone
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8. Sonicate the ion transfer tube in distilled water.

9. Clean the ion sweep cone by wiping the inside and outside with methanol and a 
Kimwipe.

10. Remove, clean with methanol, and inspect the Vespel™ O-ring (P/N 97055-20442) that 
is seated in the spray cone under the entrance end of the ion transfer tube. Replace it if 
necessary.

11. Reseat the O-ring in the spray cone.

12. Insert the ion transfer tube into the heater block. Rotate the tube as you insert it. After 
you insert it, turn the tube clockwise until it is fingertight.

13. Align the gas inlet on the ion sweep cone with the sweep gas supply port on the ion source 
mount. Firmly press the ion sweep cone into the ion source mount. See Figure 44 and 
Figure 45.

14. Reinstall the Ion Max or Ion Max-S source housing on the mass spectrometer as described 
in the topic “Installing the Ion Max or Ion Max-S Ion Source Housing” on page 69.

Figure 44. Ion source interface, showing the sweep gas supply port in the API cone seal

CAUTION  When you reinstall the ion transfer tube, take these precautions:

• Ensure that everything is properly aligned to prevent stripping the threads on the 
ion transfer tube.

• For mass spectrometers other than the TSQ Vantage, be careful not to bend the 
ion transfer tube. Rotate the tube as you insert it. (The ion transfer tube of the 
TSQ Vantage will bend slightly when you insert it.)

Sweep gas supply port
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Figure 45. Ion sweep cones for FAIMS and APPI (left) and H-ESI, ESI, and APCI (right), showing the 
gas inlets

Note  Unblocking the ion transfer tube should increase the Convectron gauge pressure to 
a normal value (approximately 1.5 Torr). If this method fails to clear the ion transfer tube, 
replace it. See Table 6 for the correct ion transfer tube part number for your instrument.

Table 6. Ion transfer tube part numbers

Instrument Ion transfer tube part number

TSQ Vantage series 70005-20423

TSQ Quantum Access series 70111-20972

TSQ Quantum Ultra series 97055-20199

TSQ Quantum Discovery Max 70111-20396

TSQ Quantum Discovery 70111-20100

TSQ Quantum AM 70111-20100

TSQ Quantum 70111-20100

Gas inlets
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Maintaining the Ion Source Interface Assembly 
The ion source interface assembly includes the ion sweep cone, ion transfer tube, capillary 
heater assembly, S-lens or tube lens, and exit lens or skimmer. The ion transfer tube has a 
finite lifetime. You must replace the ion transfer tube if the ion transfer tube bore becomes 
corroded. 

You can easily remove the ion sweep cone and ion transfer tube to clean or replace them 
without venting the system. See “Maintaining the Ion Sweep Cone and Ion Transfer Tube” on 
page 77.

To clean the ion source interface assembly components, other than the ion sweep cone and 
ion transfer tube, follow these procedures:

1. Shutting Down and Venting the System

2. Removing the Ion Max or Ion Max-S Ion Source Housing

3. Removing the Ion Source Interface

4. Removing the S-Lens and Exit Lens (TSQ Vantage) 

5. Cleaning the S-Lens and Exit Lens (TSQ Vantage)

6. Removing the Tube Lens and Skimmer (TSQ Quantum Access, TSQ Quantum Access 
MAX, or TSQ Quantum Ultra)

7. Cleaning the Tube Lens and Skimmer (TSQ Quantum Access, TSQ Quantum Access 
MAX, or TSQ Quantum Ultra)

8. Reinstalling the S-Lens and Exit Lens (TSQ Vantage)

9. Reinstalling the Tube Lens and Skimmer (TSQ Quantum Access, TSQ Quantum Access 
MAX, or TSQ Quantum Ultra)

10. Reinstalling the Ion Source Interface Assembly

11. Reinstalling the Ion Max or Ion Max-S Ion Source Housing

12. Starting Up the System

Shutting Down and Venting the System

Shut down and vent the system. See “Shutting Down the System Completely” on page 50.

Removing the Ion Max or Ion Max-S Ion Source Housing

You must remove the Ion Max or Ion Max-S ion source housing to access the ion source 
interface assembly. See “Removing the Ion Max or Ion Max-S Ion Source Housing” on 
page 67.
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Removing the Ion Source Interface

You must remove the ion source interface to access the exit lens or skimmer, the S-lens or tube 
lens, and the capillary heater assembly.

To remove the ion source interface 

1. Wear clean, talc-free gloves.

2. Using a right-to-left motion, move the ion source interface release lever several times to 
loosen the ion source interface from the ion optics cage assembly. See Figure 46.

3. Grab the exposed outer grooves of the ion source interface and firmly pull the assembly 
straight out.

4. Place the assembly on a clean, lint-free surface.

Figure 46. Removing the ion source interface

CAUTION  Wait for the ion source interface to cool to ambient temperature before you 
remove it. 

Ion optics cage 
assembly

Notch

Ion source mount

Ion source interface 
release lever

Ion source interface
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Removing the S-Lens and Exit Lens (TSQ Vantage)

You must remove the S-lens and exit lens from the ion source interface cage before they can be 
cleaned.

To remove the S-lens and exit lens from the ion source interface assembly 

1. Wearing clean, lint- and powder- free gloves, loosen and extend the two thumbscrews that 
secure the S-lens to the ion source interface cage and the exit lens to the S-lens. See 
Figure 47.

2. Grasp the two thumbscrews and carefully pull the S-lens straight out of the ion source 
interface cage. Place it on a clean, lint-free surface.

3. Remove the exit lens from the S-lens and place it on a clean, lint-free surface.

Figure 47. Removing the exit lens and S-lens from the ion source interface cage of the 
TSQ Vantage

Exit lens

S-lens

Thumbscrews

Lead pin

Lead pin socket

Ion source interface 
cage
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Maintaining the Ion Source Interface Assembly
Cleaning the S-Lens and Exit Lens (TSQ Vantage)

To clean the S-lens and exit lens

1. Sonicate the exit lens and S-lens separately for 15 minutes in 50:50 HPLC-grade 
methanol/water. 

2. Rinse the exit lens and S-lens with fresh methanol. 

3. Air dry the exit lens and S-lens or blow dry them with nitrogen gas. Ensure that all solvent 
has evaporated from the components before reassembly. 

Removing the Tube Lens and Skimmer (TSQ Quantum Access, TSQ Quantum Access 
MAX, or TSQ Quantum Ultra)

You must remove the tube lens and skimmer from the ion source interface assembly before 
they can be cleaned.

To remove the tube lens and skimmer from the ion source interface assembly 

1. Wearing clean, lint- and powder- free gloves, reach behind the skimmer with your fingers 
and gently press the skimmer out of the contact ring support. If necessary, loosen the set 
screws. See Figure 48.

2. Place the skimmer on a clean, lint-free surface.

3. Push the tube lens, from the back, out of the contact ring support.

4. Place the tube lens on a clean, lint-free surface.

Note  Wear clean gloves when you handle the S-lens and exit lens.

CAUTION  Do not clean the S-lens or exit lens with detergents, acidic or caustic 
substances, or abrasives.
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Figure 48. Removing the skimmer and tube lens from the ion source interface cage of the 
TSQ Quantum Access, TSQ Quantum Access MAX, or TSQ Quantum Ultra

Cleaning the Tube Lens and Skimmer (TSQ Quantum Access, TSQ Quantum Access 
MAX, or TSQ Quantum Ultra)

To clean the tube lens and skimmer 

Sonicate the tube lens and skimmer alone in organic or aqueous solution. For most cleaning 
applications, HPLC-grade methanol is the solvent of choice. However, use of buffers or salt 
solutions might require that you use an aqueous solution. If you need to use a solvent other 
than methanol, after cleaning the component, flush the component with distilled water and 
then flush it with methanol as a final wash. You can air dry the skimmer and tube lens or blow 
dry them with nitrogen gas. In all cases, ensure that all solvent has evaporated from the 
components before reassembly. 

Skimmer

Contact ring support

Ion source interface 
cage

Tube lens

Note  Wear clean gloves when you handle the tube lens and skimmer.

CAUTION  Do not clean the tube lens or skimmer with detergents, acidic or caustic 
substances, or abrasives.

The sharp edge of the skimmer cone is fragile and any deformation might result in a loss 
of efficient ion transmission. Use care not to drop the skimmer when cleaning it. Sonicate 
the skimmer alone with the cone side up.
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Maintaining the Ion Source Interface Assembly
Reinstalling the S-Lens and Exit Lens (TSQ Vantage)

To reinstall the S-lens and exit lens

1. Reinstall the exit lens onto the S-lens:

a. Wearing clean, lint- and powder- free gloves, extend the thumbscrews on the S-lens. 
See Figure 47 on page 84.

b. Insert the exit lens lead pin into the lead pin socket and seat the exit lens onto the 
S-lens.

2. Reinstall the exit lens and S-lens into the ion source interface cage:

a. Hold the S-lens by the thumbscrews and orient the thumbscrews toward the 
thumbscrew holes on the ion source interface. Only one orientation will work.

b. Carefully insert the S-lens into the ion source interface cage.

c. Tighten the thumbscrews until fingertight.

Reinstalling the Tube Lens and Skimmer (TSQ Quantum Access, TSQ Quantum 
Access MAX, or TSQ Quantum Ultra)

To reinstall the tube lens and skimmer

1. Reinstall the tube lens into the ion source interface cage (see Figure 49):

a. Orient the tube lens so that the lead pin points toward the socket on the tube lens 
connection wire in the contact ring support.

b. Insert the lead pin into the socket and firmly press the tube lens into the contact ring 
support. 

2. Reinstall the skimmer into the ion source interface assembly:

a. Orient the skimmer so that the lead pin points toward the socket on the tube lens 
connection wire in the contact ring support.

b. Insert the lead pin into the socket and firmly press the skimmer into the contact ring 
support.

CAUTION  Ensure that you do not scratch or nick the skimmer cone.
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Figure 49. Ion source interface cage of the TSQ Quantum Access, TSQ Quantum Access 
MAX, or TSQ Quantum Ultra, showing the skimmer and tube lens lead pin 
sockets

Reinstalling the Ion Source Interface Assembly

To reinstall the ion source interface assembly 

1. Orient the ion source interface assembly so that the sweep gas inlet notch on the ion 
source interface is aligned with the sweep gas supply block on the ion source mount.

2. Carefully slide the ion source interface assembly into the ion optics cage assembly.

Reinstalling the Ion Max or Ion Max-S Ion Source Housing

Reinstall the Ion Max or Ion Max-S ion source housing as described in the topic “Installing 
the Ion Max or Ion Max-S Ion Source Housing” on page 69.

You might also need to reinstall an ion source probe and LC liquid lines, as appropriate, as 
described in the corresponding topics in the TSQ Series Getting Connected Guide.

Starting Up the System

Start up the system as described in the topic “Starting Up the System after a Complete 
Shutdown” on page 52.

Ion source interface 
cage

Contact ring support

Skimmer lead pin 
socket

Tube lens lead pin socket
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Cleaning the Q00 Ion Optics 
Because an accumulation of chemicals on the surfaces of the tube lens, skimmer, and 
Q00 rf lens forms an insulating layer that can modify the electrical fields that control ion 
transmission, clean ion optics components are essential for the proper operation of the 
instrument. The tube lens and skimmer require cleaning less often than the API source. The 
Q00 rf lens requires cleaning less often than the tube lens and skimmer. The frequency of 
cleaning depends on the type and quantity of the compounds that you analyze.

Clean or replace the Q00 ion optics components by doing the following:

1. Shutting Down and Venting the System

2. Removing the Ion Max or Ion Max-S Ion Source Housing

3. Removing the Ion Source Interface

4. Removing the Ion Optics Cage Assembly

5. Disassembling the Ion Optics Cage Assembly

6. Cleaning Q00 and L0

7. Reassembling the Ion Optics Cage Assembly

8. Reinstalling the Ion Optics Cage Assembly

9. Reinstalling the Ion Source Interface Assembly

10. Reinstalling the Ion Max or Ion Max-S Ion Source Housing

11. Starting Up the System

Shutting Down and Venting the System

Shut down and vent the system as described in the topic “Shutting Down the System 
Completely” on page 50.

Removing the Ion Max or Ion Max-S Ion Source Housing

Remove the Ion Max or Ion Max-S ion source housing to access the ion source interface 
assembly. Remove the Ion Max or Ion Max-S ion source housing as described in the topic 
“Removing the Ion Max or Ion Max-S Ion Source Housing” on page 67.

Removing the Ion Source Interface Assembly

Remove the ion source interface assembly to access the Q00 ion optics assembly. Remove the 
ion source interface assembly as described in the topic “Removing the Ion Source Interface” 
on page 83.
Thermo Scientific TSQ Series Hardware Manual 89



6 Maintenance
Cleaning the Q00 Ion Optics
Removing the Ion Optics Cage Assembly

To remove the ion optics cage assembly

1. Using a Phillips screwdriver, remove the three screws fastening the ion source interface 
cover to the mass spectrometer, and place the cover in a safe place. See Figure 50.

Figure 50. Removing the ion source interface cover screws

2. Using a hex ball driver, remove the roughing pump adapter access plate. See Figure 51.

Figure 51. Removing the roughing pump adapter access plate screws

Ion source interface 
cover screws

Access plate 
screws
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3. Unplug the ion source cable harness from the connector. See Figure 52.

Figure 52. Unplugging the ion source cable harness connector

4. Remove the ion optics cage assembly:

a. Using a hex ball driver, remove the three screws fastening the ion optics cage assembly 
to the ion source mount assembly. See Figure 53.

Figure 53. Removing the ion optics cage assembly retaining screws
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b. Carefully feed the cable harness back through the roughing pump adapter and out of 
the front of the cage assembly to ensure that it does not get trapped between the cage 
and the ion source mount assembly while you are removing the cage assembly. See 
Figure 54.

Figure 54. Pulling the ion source cable harness out of the ion optics cage assembly

c. Carefully slide the ion optics cage assembly out of the ion source mount assembly. See 
Figure 55.

d. Place the ion optics cage assembly on a clean, lint-free surface.
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Figure 55. Removing the ion optics cage assembly
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Disassembling the Ion Optics Cage Assembly

The Q00 rf lens and L0 lens must be removed from the ion optics cage assembly before they 
can be cleaned.

To disassemble the ion optics cage assembly 

1. Using a hex ball driver, remove the three screws that fasten the Q0 mount assembly to the 
ion optics cage. See Figure 56.

Figure 56. Ion optics cage assembly with Q0 mount assembly and Q00/L0 mount assembly 
removed

2. Remove the Q0 mount assembly. Place it on a clean, lint-free surface.

3. Using needle nose pliers, disconnect the two rf lead wires from the Q00 lead pins. 

4. Carefully push the Q00/L0 mount assembly out of the ion optics cage by pressing on the 
mount assembly with your fingers. 

5. Using a hex ball driver, remove the three Q00 mounting screws that fasten the Q00 rf lens 
assembly to the Q00/L0 mount. Leave the lens L0 mounted in the PEEK Q00/L0 
mount. 

Note  Make careful note of the proper orientation of all wiring before removing any 
electrical lead from its contact.

Note  Wear clean gloves when you handle the ion optics components. 

Q0 mount 
assembly

Q00/L0 mount 
assembly

Q0 mounting screws 
(3×)

Ion optics cage
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Figure 57. Exploded diagram of the Q00/L0 mount assembly

6. Place all components onto a clean, lint-free surface. 

Cleaning Q00 and L0

To clean the Q00 rf lens and L0 lens

1. Clean the Q00 rf lens and L0 lens with a Kimwipe™ soaked in methanol.

2. Dry the parts with a rapid stream of nitrogen gas.

3. Inspect each part for contamination and dust. If necessary, repeat the cleaning procedure.

Lead pins

Guide pin hole

Guide pin

Q00/L0 mount and 
L0 lens

Q00 rf lens 
assembly

Mounting screws 
(3×)

CAUTION  Do not disassemble the Q00 rf lens assembly any further. 

CAUTION  Do not use abrasives to clean the Q00 rf lens. Do not soak the Q00 rf lens 
and L0 lens in solvent.

Note  Wear clean gloves to handle the parts after you clean them.
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Reassembling the Ion Optics Cage Assembly

To reassemble and mount the Q00/L0 assembly

1. Reinstall the Q00 assembly on the Q00/L0 mount:

a. Orient the Q00 assembly so that the guide pin on the Q00/L0 mount inserts into the 
guide pin hole in the Q00 assembly. 

b. Secure the Q00 assembly with the 3 Q00 mounting screws.

2. Reinstall the Q00/L0 mount assembly in the ion optics cage:

a. Orient the Q00/L0 mount assembly so that the lead pins are closest to the lead wires 
in the ion optics cage. 

b. Press the Q00/L0 assembly into the ion optics cage. See Figure 56.

3. Use needle nose pliers to carefully reconnect the top rf lead wire to the top Q00 lead pin 
and the bottom rf lead wire to the bottom Q00 lead pin. 

4. Reinstall the Q0 mount assembly onto the ion optics cage:

a. Orient the Q0 mount assembly so that the flat side is on the same side as the two 
contacts. 

b. Secure the Q0 mount assembly on the ion optics cage with the 3 Q0 mounting 
screws. See Figure 56.
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Reinstalling the Ion Optics Cage Assembly

To reinstall the ion optics cage assembly

1. Reinstall the 3.25 in. ID Viton™ O-ring into the groove on the ion source mount 
assembly. See Figure 58.

Figure 58. Ion source mount assembly, showing groove for O-ring

2. Orient the ion optics cage assembly with the contact pins down, and then partially insert 
it into the ion source mount assembly. 

3. Feed the cable harness into the roughing pump adapter and reconnect the cable. Rotate 
the ion optics cage assembly if necessary.

4. Insert the ion optics cage assembly completely so that the two interstage contact pins are 
inserted into the sockets in the ion source mount assembly.

5. Ensure that the 3.25 in. ID Viton O-ring is properly seated between the ion optics cage 
assembly and the ion source mount assembly.

6. Carefully press the wiring harness down into the recess in the bottom of the ion source 
mount assembly so that the wires are out of the path of the ion source interface assembly 
that you will install in the next procedure. See Figure 59.

Groove for O-ring
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Figure 59. Ion optics cage assembly, installed 

7. Reinstall the three ion optics cage assembly screws that fasten the cage assembly to the ion 
source mount assembly. See Figure 53.

8. Plug in the ion source cable harness connector. Secure the connector. See Figure 52.

9. Reinstall the roughing pump adapter access plate and screws. See Figure 51.

10. Reinstall the ion source interface cover and screws. See Figure 50.

Reinstalling the Ion Source Interface Assembly

Reinstall the ion source interface assembly as described in the topic “Reinstalling the Ion 
Source Interface Assembly” on page 88.

Reinstalling the Ion Max or Ion Max-S Ion Source Housing

Reinstall the Ion Max or Ion Max-S ion source housing as described in the topic “Installing 
the Ion Max or Ion Max-S Ion Source Housing” on page 69.

Starting Up the System

Start up the system as described in the topic “Starting Up the System after a Complete 
Shutdown” on page 52.

Recess in bottom of ion source 
mount assembly

Cable harness
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Maintaining the Forepump
The forepump is located under the TSQ work table. Inspecting, adding, purging, and 
changing the oil are all that is required to maintain the forepump.

Forepump oil is a translucent, light amber color, which you must check often. During normal 
operation, oil must always be visible in the oil level sight glass between the MIN and MAX 
marks. If the oil level is below the MIN mark, add oil. If the oil is cloudy or discolored, purge 
the oil to decontaminate dissolved solvents. If the pump oil is still discolored, change it. Plan 
to change the pump oil after every 3000 hours (about four months) of operation. Refer to the 
manufacturer’s documentation for procedures for purging, adding, and changing the 
forepump oil. 

Cleaning the Fan Filters
You must clean the two fan filters every four months. The fan filters are located on the rear of 
the front cover and on the right side cover of the TSQ Series mass spectrometer.

To clean the fan filters

1. Remove the fan filter from the right side cover:

a. On the TSQ Vantage, using a Phillips screwdriver, remove the six screws that hold 
the blue appliqué to the right-side cover.

b. Remove the appliqué.

c. Loosen and remove the four screws that hold the filter bracket to the right-side cover. 
Note that from the outside of the mass spectrometer the filter bracket appears to be a 
grille.

d. Remove the filter and filter bracket.

2. Remove the fan filter from the front cover:

a. Remove the front cover of the TSQ mass spectrometer:

i. Disconnect all tubing to the divert/inject valve and syringe pump.

ii. Depress the two (blue) spring catches that are located on either side of front 
cover.

iii. Pull the front cover straight off by about 6 in. (15 cm) to access the Front Panel 
PCB cable and the two grounding wires.

iv. Disconnect the Front Panel PCB cable from the TSQ mass spectrometer by 
pushing the connector retainer up and then pulling the cable free.

v. Pull the two grounding wires free from their respective spade connectors.

vi. Remove the front cover.
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b. Loosen and remove the four screws that hold the filter bracket to the front cover.

c. Remove the filter and filter bracket.

3. Wash the fan filters in a solution of soap and water.

4. Rinse the fan filters with tap water.

5. Squeeze the water from the fan filters and allow them to air dry.

6. Reinstall the fan filter on the right-side cover:

a. Place the filter in the filter bracket and position the filter bracket and filter on the 
right-side cover.

b. Install and tighten the four screws that hold the filter bracket to the right-side cover.

c. On the TSQ Vantage, position the blue appliqué on the right-side cover.

d. Install and tighten the six screws that hold the appliqué to the right-side cover.

7. Reinstall the fan filter on the front cover:

a. Place the filter in the filter bracket and position the filter bracket and filter on the rear 
of the front cover.

b. Install and tighten the four screws that hold the filter bracket to the front cover.

c. Reinstall the front cover of the TSQ mass spectrometer.

i. Position the front cover about 6 in. (15 cm) from the TSQ mass spectrometer.

ii. Reconnect the grounding wire to the space connector.

iii. Reconnect the Front Panel PCB cable to the TSQ mass spectrometer by inserting 
the cable into the connector. Push the connector retainer down to secure the 
cable.

iv. Align the front cover with the two guide pins on the TSQ mass spectrometer.

v. Push the front cover against the TSQ mass spectrometer until the two spring 
catches lock.

vi. Reconnect all tubing to the divert/inject valve and the syringe pump.
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Diagnostics and PCB and Assembly Replacement

The TSQ system diagnostics can test many components of the TSQ mass spectrometer. If 
there is a problem with the instrument electronics, the diagnostics can often locate the 
problem. Replacing a faulty PCB or assembly can usually correct the problem. After the PCB 
or assembly is replaced, the diagnostic tests are rerun to verify that the instrument is 
functioning properly.

Note  Three levels of protection are possible:

• No protection—All operators can access all workspaces.

• Automatic protection—Tune Master uses the default password, lctsq, to protect the 
secure workspaces.

• Custom password protection—The Key Operator (or Laboratory Administrator or 
Manager) can select a password to protect the secure workspaces.

If your TSQ system has been password protected, you must obtain the password before 
you can access the secure workspaces (including the System Tune and Calibration 
workspace). If the instrument password is lost, you must reinstall the TSQ software to 
reset the default password (lctsq).

Contents

• Running the TSQ System Diagnostics

• Replacing a Fuse

• Replacing PCBs and Power Supplies
Thermo Scientific TSQ Series Hardware Manual 101



7 Diagnostics and PCB and Assembly Replacement
Running the TSQ System Diagnostics
Running the TSQ System Diagnostics 
The TSQ system diagnostics are used to test the major electronic circuits within the 
instrument and indicate whether the circuits pass or fail the tests. If there is a problem with 
the instrument electronics, the TSQ system diagnostics can often locate the problem.

The TSQ system diagnostics do not diagnose problems that are not electrical in nature. For 
example, they do not diagnose poor sensitivity due to misaligned or dirty components or to 
improper tuning. Therefore, it is important that the person running the diagnostics be 
familiar with system operation and basic hardware theory as well as the details of the 
diagnostics.

Typically, only a Thermo Fisher Scientific field service engineer runs diagnostic tests because 
certain tests can overwrite system parameters. However, before calling a Thermo Fisher 
Scientific field service engineer to run diagnostics, consider the following:

• Did the system fail when you were running samples?

• Did problems occur after you performed maintenance on the instrument, data system, or 
peripherals?

• Did you change the configuration of the system, cables, or peripherals just before the 
problem occurred?

If the answer is yes to the first item above, there is the possibility of a hardware failure, and 
running the diagnostics is appropriate.

If the answer is yes to either of the last two questions above, the problem is probably 
mechanical, not electrical. Verify again that alignment, configurations, and cable connections 
are correct before you call the Thermo Fisher Scientific field service engineer. Keep careful 
notes documenting the nature of the problem and the corrective steps you have taken. If you 
are not successful in correcting the problem, you can e-mail this information to your field 
service engineer. The Field Service department can then do a preliminary evaluation of the 
problem before an engineer arrives at your site.

CAUTION  Non-expert users should run only the following diagnostics: 

• Ion Source Board

• System Control 

• Analyzer Control Board
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Replacing a Fuse
To run diagnostics

1. Open TSQ Tune Master:

a. Right-click the Start button and select Explore.

b. Browse to the C:\Thermo\Instruments\TSQ\system\programs folder.

c. Double-click TSQTune.

2. Choose Workpace > Full Instrument Control to display the Full Instrument Control 
Workspace.

3. Choose Workpace > Diagnostics to display the Diagnostics Workspace.

4. Select Test Name: Ion Source Board, System Control, or Analyzer Control Board.

5. Select how many times you want to run the tests.

6. Click on the Start button to start the diagnostics.

Replacing a Fuse
Fuses protect the various circuits by opening the circuits whenever overcurrent occurs. On the 
TSQ mass spectrometer, a failed fuse indicates a failed board or electronic module that must 
be replaced by a Thermo Fisher Scientific field service engineer.

Replacing PCBs and Power Supplies 
The electronic assemblies that control the operation of the mass spectrometer are distributed 
among various PCBs and other modules located in the tower, in the embedded computer, and 
on or around the vacuum manifold of the mass spectrometer.

CAUTION  Non-expert users should run only the following diagnostics: 

• Ion Source Board

• System Control 

• Analyzer Control Board

CAUTION  Due to the complexity of accessing the TSQ mass spectrometer electronic 
assemblies, only a Thermo Fisher Scientific field service engineer can replace fuses.

CAUTION  The TSQ mass spectrometer electronic assemblies are close-packed to 
minimize the size of the system. Due to the complexity of removing and reinstalling the 
TSQ mass spectrometer electronic assemblies, only a Thermo Fisher Scientific field service 
engineer can replace electronic assemblies.
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Replaceable Parts

This chapter contains part numbers for replaceable and consumable parts for the mass 
spectrometer and kits. To ensure proper results in servicing the TSQ system, order only the 
parts listed or their equivalent. 

MS Accessory Kit
Accessory Kit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70111-62034

Fuse, 0.25 A, 250 V, 5×20  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00006-01700
Fuse, 0.25 A, 250 V, 5×20  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00006-05080
Fuse, 0.50 A, 250 V, 5×20  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00006-07608
Fuse, 1.0 A, 250 V, 5×20  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00006-07610
Fuse, 2.0 A, 250 V . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00006-09102
Fuse, 1.0 A, 250 V, 5×20  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00006-10510
Fuse, 4.0 A, 250 V . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00006-10705
Fuse, 0.16 A, 250 V, 5×20  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00006-11204
Fuse, 4 A, 250 V. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00006-11420
Fuse, 1.0 A, 250 V . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00006-14015
Fuse, 6.3 A, 250 V, 5×20  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00006-11450
Fitting, ferrule, Swagelok, Back, 1/8 in. . . . . . . . . . . . . . . . . . . . . . . . . . . 00101-02500
Fitting, ferrule, Swagelok, Back, 1/4 in. . . . . . . . . . . . . . . . . . . . . . . . . . . 00101-04000
Fitting, ferrule, Swagelok, Front, 1/8 in.  . . . . . . . . . . . . . . . . . . . . . . . . . 00101-08500
Fitting, ferrule, Swagelok, Front, 1/4 in.  . . . . . . . . . . . . . . . . . . . . . . . . . 00101-10000
Fitting, Swagelok, Nut, 1/4 in., brass . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00101-12500

Contents

• MS Accessory Kit

• TSQ Vantage Instrument Specific Accessory Kit

• TSQ Quantum Ultra, Ultra AM, and Ultra EMR Instrument Specific 
Accessory Kit

• HESI-II Probe Kit

• TSQ Quantum Access Instrument Specific Accessory Kit

• TSQ Accurate Mass Calibration Compounds Kit

• Fittings, Ferrules, and Sample Loops
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TSQ Vantage Instrument Specific Accessory Kit
Fitting, Swagelok, Nut, 1/8 in., brass . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00101-15500
Fitting, HPLC adaptor, 10-32 × 1/4-28 . . . . . . . . . . . . . . . . . . . . . . . . . . 00101-18080
Ferrule, 0.008 in. ID, KEL-F™, HPLC  . . . . . . . . . . . . . . . . . . . . . . . . . . 00101-18114
Fitting, Fingertight 2, Upchurch™. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00101-18195
Ferrule, Fingertight 2, Upchurch . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00101-18196
Fitting, HPLC, Tee, 0.020 orifice, PEEK . . . . . . . . . . . . . . . . . . . . . . . . . 00101-18204
Tubing, fused silica, 0.150 mm × 0.390 mm. . . . . . . . . . . . . . . . . . . . . . . 00106-10498
Tubing, fused silica, 0.10 mm ID × 0.19 mm OD . . . . . . . . . . . . . . . . . . 00106-10499
Tubing, fused silica, 0.05 mm ID × 0.19 mm OD,

deactivated . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00106-10502
Tube, hypodermic 28-gauge × 10 in.  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00106-20000
Fitting, HPLC, 10-32, long, one piece . . . . . . . . . . . . . . . . . . . . . . . . .00109-99-00016
Septa. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00301-16999
Syringe, 500 μL, Gastight™ , Removable needle  . . . . . . . . . . . . . . . . . . . . 00301-19016
Tubing, PEEK, 0.005 ID × 1/16 in. OD, Red,

5 ft. (1.5 m long)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00301-22912
Tubing, Teflon™, 0.030 in. ID × 1/16 in. OD  . . . . . . . . . . . . . . . . . . . . . 00301-22915
Syringe Adapter Kit  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70005-62011
Needle, Corona, APCI . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70005-98033
Tool, ion transfer tube removal . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70111-20258
O-ring, graphite Vespel (for ion transfer tube)  . . . . . . . . . . . . . . . . . . . . . 97055-20442

TSQ Vantage Instrument Specific Accessory Kit
Accessory Kit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70111-62081

5/32 Ball driver. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00025-10020
Reserpine  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00301-12901
Ultramark 1621 (EMR only)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00301-12200
Ion transfer tube . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70005-20423
Polytyrosine, liquid . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00301-22924
Polytyrosine, solid. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00301-22925
Cable, LC/MS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60053-63035

TSQ Quantum Ultra, Ultra AM, and Ultra EMR Instrument Specific 
Accessory Kit

Accessory Kit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70111-62057
5/32 Ball driver. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00025-10020
Ultramark 1621 (EMR only)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00301-12200
Reserpine  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00301-12901
Needle seal . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 07055-20271
ESI needle  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 07055-20273
Kit, metal needle, H-ESI  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97055-62026
Ion transfer tube . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97055-20199
Polytyrosine, liquid . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00301-22924
Polytyrosine, solid. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00301-22925
Cable, LC/MS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60053-63035
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 8 Replaceable Parts
HESI-II Probe Kit
HESI-II Probe Kit
HESI-II Probe Kit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . OPTON 20037
High-flow needle insert assembly . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . OPTON-53010
Low-flow needle insert assembly. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . OPTON-53011

The HESI-II Probe Kit contains the HESI-II probe with a factory-installed high-flow 
needle insert. The high-flow metal needle insert is suitable for flow rates equal to or greater 
than 5 μL/min. For low-flow rate applications, order the low-flow needle insert assembly. 

TSQ Quantum Access Instrument Specific Accessory Kit
Accessory Kit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70111-62059

Reserpine  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00301-12901
Ultramark 1621 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00301-12200
Needle seal . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00950-00952
ESI needle  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00950-00990
Ion transfer tube . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70111-20972
Polytyrosine, liquid . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00301-22924
Polytyrosine, solid. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00301-22925
Kit, metal needle, high flow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70005-62013
Kit, metal needle, low flow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97144-62080
Cable, LC/MS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60053-63035
CsI . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . HAZMAT-01-00004

TSQ Accurate Mass Calibration Compounds Kit
Calibration Compounds Kit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70111-62029

Polyethelene glycol, 1000 molecular weight, 5 g . . . . . . . . . . . . . . . . . . . . 00301-07710
Polyethelene glycol, 200 molecular weight, 5 g . . . . . . . . . . . . . . . . . . . . . 00301-07712
Polyethelene glycol, 400 molecular weight, 5 g . . . . . . . . . . . . . . . . . . . . . 00301-07714
Polyethelene glycol, 600 molecular weight, 5 g . . . . . . . . . . . . . . . . . . . . . 00301-07716

Fittings, Ferrules, and Sample Loops
Ferrule, Fingertight 2, Upchurch. 

(for: PEEK tubing and Teflon tube) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00101-18196
Ferrule, 0.016 in. ID, PEEK, Upchurch 

(for: Fused-silica capillary infusion line) . . . . . . . . . . . . . . . . . . . . . . . . . . 00101-18120
Ferrule, 0.012 in. ID, Kel-F, Upchurch 

(for: High flow metal needle and low flow metal needle)  . . . . . . . . . . . . . 00101-18114
Ferrule, 0.008 in. ID, Kel-F, Upchurch 

(for: Fused-silica capillary sample line).. . . . . . . . . . . . . . . . . . . . . . . . . . . 00101-18116
Ferrule, LC, 1/16 in., stainless steel, Rheodyne . . . . . . . . . . . . . . . . . . . . . . . . . . 2522-3830
Fitting, Fingertight, Upchurch. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00101-18195
Fitting, Fingertight, Upchurch. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00101-18081
Thermo Scientific TSQ Series Hardware Manual 107



8 Replaceable Parts
Fittings, Ferrules, and Sample Loops
Fitting, adapter, Kel-F, 10-32 × 1/4-28, Upchurch 
(connects directly to ESI probe inlet). . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00101-18080

Nut, LC, 1/16 in., stainless steel, Rheodyne. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2522-0066
Fitting, LC union, 0.010 in. orifice, PEEK.. . . . . . . . . . . . . . . . . . . . . . . . . . . 00101-18202
Fitting, LC TEE union, 0.020 in. orifice, PEEK . . . . . . . . . . . . . . . . . . . . . . . 00101-18204
Fitting, adapter union, PEEK, Upchurch. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00101-18206
5 μL sample loop, stainless steel. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 00110-22010
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I

Index
A
accessory kit  105
air leaks, checking for  62
analyzer assembly, lenses, voltages applied to  35
analyzer chamber, location (figure)  38
Analyzer Control PCB, discussion  44
analyzer region, vacuum manifold, description  38
anode, electron multiplier, description  35
API probe, flushing  64
argon inlet, location (figure)  42
argon supply

checking  62
pressure  62

atmospheric pressure ionization (API) source
description  69
ion source interface  22

autosampler
about  14
configuring  14
startup  53

auxiliary gas pressure  42
auxiliary gas valve, description  42
auxiliary gas, on/off status  58

C
calibration

and H-SRM (note)  61
discussed  61
frequency (note)  54, 61

capillary, heated. See ion transfer tube
cathode, electron multiplier, description  35
Cautions

capillary heater cage assembly temperature  83
emergency shutdown  47
forepump and line power  40
lower ion transfer tube temperature before removing  

77
nitrogen supply and API source operation  62

replacing fuses  103
replacing PCBs and power supplies  103
scratching the skimmer cone  87
solvent waste backing into ion source housing  70

centroid scan, defined  12
CID. See collision-induced dissociation
circuit breaker  20
cleaning procedures

API probe, flushing  64
ESI probe, flushing  64
exit lens  85
frequency  75
ion sweep cone  76
ion transfer tube  66, 76
Q00 ion optics  89
Q00 rf lens  89, 95
sample transfer line  64
sample tube  64
skimmer  85–86
S-lens  85
sweep cone  66
tube lens  85–86

collision cell
figure  30
location (figure)  38

collision energy (Q2 offset voltage)  34
collision gas valve, description  41
collision gas, description  32
collision-induced dissociation (CID), discussion  32
Communication LED

description  19
mass spectrometer reset  55
mass spectrometer startup  53

compliance
EMC  iii
FCC  v
regulatory compliance  iii
WEEE  vii

computer, features  44
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Index: D
Convectron gauge
description  40
location (figure)  38
pressure readings (table)  63, 81

conversion dynode
description  35
figure  36
on/off status  58

D
daily maintenance

API probe, flushing  64
emptying solvent waste bottle  66
ion sweep cone, flushing  66, 76
ion transfer tube, flushing  66, 76
sample tube, flushing  64
transfer line, flushing  64

daily system checks
air leaks  62
argon supply  62
check list  64
list  61
nitrogen supply  62
overview  61

data system
description  44
instrument interface  45
interconnect diagram  46
LAN interface  45
LC interface  45
personal computer  44
primary Ethernet adapter  45
resetting  55
shutdown  51

data types, discussed  11
data-dependent scan mode, discussed  9
diagnostics

Caution  102
running  102

divert/inject valve
description  16
location (figure)  17
loop injection  16
plumbing (figure)  17

dynode  35

E
electron multiplier

anode, description  35
description  35
on/off status  58

electronic assemblies
description  42, 103
ion detection system  43
Power Entry Module, description  42
rf voltage generation, description  43

electronics service switch
and complete shutdown  50
location  48
mass spectrometer components on/off status  58

embedded computer
description  43
resetting  55

EMC compliance  iii
emergency shutdown procedure  47
ESI probe, flushing  64
Ethernet Link OK LED  22
exit lens

cleaning  85
reinstalling  87
removing  84

F
FCC compliance  v
filters  42
fittings, replaceable parts  107
forepump

description  40
maintenance  99
on/off status  58
power cord (Caution)  40

front panel LEDs
Communication  19
description  19
figure  19
Power  19
Scan  19
System  19
Vacuum  19

full scan type  10
functional description

data system  44
divert/inject valve  16
liquid chromatograph  15
mass analyzer  28
mass spectrometer  18
syringe pump  15
TSQ  13

fuses, mass spectrometer, replacing  103
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Index: I
I
inlet gasses hardware

auxiliary gas valve  42
collision gas valve  41
description  37
sheath gas valve  41

Instrument Configuration window, opening  14
interconnect diagram  46
ion detection system

conversion dynode  35
electron multiplier  35
electron multiplier gain  36
electronic assemblies  43

ion gauge
description  40
pressure readings (table)  63, 81

Ion Max API source
housing (figure)  68
housing, rear (figure)  69
installing  69
maintenance  73

Ion Max-S API source
housing (figure)  68
installing  69

ion optics
cage assembly location (figure)  83–84, 86
description  24
Q0 quadrupole, discussion  27
Q00, description  24

ion optics cage assembly
disassembling  94
exploded view (figure)  94
reinstalling  97

ion polarity modes, discussed  3
ion source interface

cross-sectional view  23
description  22
figure  83–84, 86
ion transfer tube  23
location (figure)  80
maintenance  82
reinstalling  88
release lever (location)  70
removing  83

ion source mount
figure  70
guide pins  70
location (figure)  83–84, 86

ion source, description  3
ion sweep cone

cleaning  79
description  24

figure  79
flushing  66, 76
location (figure)  23

ion transfer tube
description  23
figure  24
flushing  66, 76
location (figure)  23
lower temperature before removing (Caution)  77
part numbers  81
removing and cleaning  76
setting temperature  77

ion transmission device
defined  4
rod assembly  4

L
leaks, checking for  62
LEDs

Communication LED  19
Communication LED, mass spectrometer reset  55
Communication LED, mass spectrometer startup  53
divert/inject valve LEDs  20
Ethernet Link OK  22
Power LED  19
Power LED, mass spectrometer reset  55
Power LED, mass spectrometer startup  53
Pump On, location (figure)  22
Scan LED  19
syringe pump LED  16, 19
System LED  19
System LED, mass spectrometer reset  55
System LED, mass spectrometer startup  53
Vacuum LED  19
Vent Valve Closed  21

lens L0, description  27
lenses

analyzer assembly, voltages applied to  35
L21, L22, L23, figure  30
L31, L32, L33, figure  30

liquid chromatograph (LC)
about  15
configuring  15
functional description  15
interconnect diagram  46
startup  52
supported  15

loop injection, divert/inject valve  16

M
main power circuit breaker, description  20
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Index: N
maintenance
API probe, flushing  64
exit lens, cleaning  85
forepump  99
frequency (table)  74
Ion Max API source  73
Ion Max-S API source  73
ion source interface  82
ion sweep cone, cleaning  76
ion transfer tube, cleaning  66, 76
ion transfer tube, removing and cleaning  76
Q00 ion optics, cleaning  89
Q00 rf lens, cleaning  89, 95
sample transfer line, flushing  64
sample tube, flushing  64
skimmer, cleaning  85–86
S-lens, cleaning  85
sweep cone, cleaning  66
tube lens, cleaning  85–86

mass analysis
collision-induced dissociation (CID)  32
discussion  32
rf and dc fields (figure)  30

mass analyzer
defined  4
description  28
on/off status  58

mass ranges  12
mass spectrometer

collision gas valve  41
diagnostics  102
electronic assemblies  42, 103
emergency shutdown  47
frequency of cleaning  75
front panel LEDs  19
functional description  18
fuses, replacing  103
inlet gasses hardware  37
interconnect diagram  46
ion detection system electronic assemblies  43
ion gauge  40
LEDs and system startup  55
maintenance procedures (table)  74
mass analyzer  28
Off condition  58
Power Entry Module, description  42
pressure readings (table)  63, 81
resetting  55
RF voltage generation electronic assemblies  43
shutdown  50
Standby condition  49
starting up  52
turbomolecular pump  39

vacuum manifold  38
vacuum system  36
vent valve  41

mechanical pump  40
MS main power circuit breaker

mass spectrometer components on/off status  58
MS/MS scan modes

neutral loss  7
parent  6
product  5

N
neutral Loss scan mode

illustration (figure)  8
neutral loss scan mode

discussed  7
example (figure)  9

nitrogen
pressure  42
rate of consumption  62

nitrogen inlet, location (figure)  42
nitrogen supply

Caution  62
checking  62
pressure  62

O
Off condition, on/off status of components  58
offset voltage, quadrupole  33

P
parent scan mode

discussed  6
illustration (figure)  6

part numbers  105
password  101
personal computer, features  44
power cord, forepump (Caution)  40
Power Entry Module, description  42
Power LED

description  19
mass spectrometer reset  55
mass spectrometer startup  53

power panel, figure  20–21
pressure levels, checking  62
printer, setting up  45
procedures

cleaning the exit lens  85
cleaning the skimmer  86
cleaning the S-lens  85
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Index: Q
cleaning the tube lens  86
complete system shutdown  50
configuring the LC  15
disassembling the ion optics cage assembly  94
installing the Ion Max API source  69
installing the Ion Max-S API source  69
maintaining the forepump  99
placing system in standby  49
reinstalling the exit lens  87
reinstalling the ion optics cage assembly  97
reinstalling the ion source interface  88
reinstalling the skimmer  87
reinstalling the S-lens  87
reinstalling the tube lens  87
removing skimmer  85
removing the exit lens  84
removing the S-lens  84
removing tube lens  85
resetting mass spectrometer  55

product scan mode
discussed  5
illustration (figure)  6

profile scan, defined  11
pumps

forepump  40
turbomolecular pump  39

Q
Q0 ion optics chamber, location (figure)  38
Q0 ion optics, discussion  27
Q0 mount assembly, location (figure)  94
Q0 quadrupole

description  27
figure  27

Q00 ion optics
cleaning  89
cleaning components  95
cross-sectional view  23
reassembling  96
skimmer  25

Q00 RF lens
description  26
figure  26
on/off status  58

Q00 rf lens
cleaning  89, 95
location (figure)  23

Q00/L0 mount assembly
exploded view (figure)  95
location (figure)  94

Q1 quadrupole, figure  29
Q1MS and Q3MS scan modes  5

Q2 rod assembly, figure  30
Q3 quadrupole, figure  29
quadrupole mass analyzer

functional description  29, 32
quadrupole offset voltage  33

quadrupoles
mass analysis  29, 32
Q0, description  27
Q1 and Q3  29
RF and dc fields (figure)  31
rf and dc fields (figure)  30

R
regulatory compliance  iii
replaceable parts

accessory kit  105
fittings  107
part numbers  105
sample loops  107

RF voltage generation, discussion  43
right side power panel

discussion  21
figure  21

rod assemblies
description  30
ion transmission  4
mass analysis  4
mass analyzer(s), quadrupole  29, 32
Q1, Q2, and Q3 (note)  5

roughing pump  40

S
safety precautions  xvi
sample loop, replaceable parts  107
sample transfer line, flushing  64
sample tube, flushing  64
scan data types

centroid scan  12
profile scan  11

Scan LED, description  19
scan modes

data-dependent  9
discussed  3
mass spectrometer  3
neutral loss  7
neutral loss, example (figure)  9
neutral loss, illustrated (figure)  8
parent  6
parent, illustrated (figure)  7
product  5
Product, illustrated (figure)  6
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Index: T
Q1MS and Q3MS  5
summary (table)  4

scan types
discussed  10
full-scan  10
selected ion monitoring (SIM)  10
selected reaction monitoring (SRM)  11

selected ion monitoring (SIM) scan type  10
selected reaction monitoring (SRM) scan type  11
sheath gas pressure  41
sheath gas valve, description  41
sheath gas, on/off status  58
shutdown

data system  51
emergency procedure  47
mass spectrometer  50
nonemergency procedure  50

side cover plate (vacuum manifold), description  39
skimmer

cleaning  86
description  25
figure  26
location (figure)  23
reinstalling  87
removing  85

S-lens
cleaning  85
on/off status  58
reinstalling  87
removing  84

solvent waste bottle, emptying  66
solvents

cleaning  86
purity requirements  xvii

Standby condition
on/off status of components  58
placing system in  49

startup
autosampler  53
liquid chromatograph  52
mass spectrometer  52
operating conditions, setting  54

sweep gas supply port, location (figure)  80
switches  21
syringe pump

description  15
figure  16

system checks
argon and nitrogen supplies  62
sample tube polyimide elongation  62
vacuum levels  62

System Control PCB, description  43
System LED

mass spectrometer reset  55
mass spectrometer startup  53

system reset button
description  21
location (figure)  21
mass spectrometer reset  55

system shutdown
emergency procedure  47
nonemergency procedure  50

T
tables

mass spectrometer components on/off status  58
mass spectrometer maintenance procedures  74
pressure readings  63, 81
summary of scan modes  4

troubleshooting  101
TSQ

autosampler  14
calibrating  61
calibration, frequency  54
complete shutdown  50
daily system checks  61
data system  44
data types  11
diagnostics  102
divert/inject valve  16
emergency shutdown  47
front panel LEDs  19
functional block diagram (figure)  13–14
functional description  13
interconnect diagram  46
ion polarity modes  3
LEDs and system startup  55
liquid chromatograph  15
mass ranges  12
mass spectrometer  18
operating conditions, setting  54
overview  1
regulatory compliance  iii
replaceable parts  105
scan modes  3
scan types  10
shutdown, emergency procedure  47
shutdown, nonemergency procedure  50
Standby condition  49
starting up  52
syringe pump  15
tuning  61
tuning, frequency  54
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Index: V
tube lens
cleaning  86
description  24
figure  24
location (figure)  23
on/off status  58
reinstalling  87
removing  85
voltages  24

Tune Master window, opening  15
tuning

discussed  61
frequency (note)  54
tube lens offset voltage  24

turbomolecular pump
description  39
on/off status  58

V
Vacuum LED

and analyzer region pressure  19
description  19

vacuum levels, checking  62
vacuum manifold

analyzer chamber, location (figure)  38
collision cell chamber, location (figure)  38
description  38
feedthroughs  39
interior (figure)  38
pressure readings (table)  63, 81
Q0 ion optics chamber, location (figure)  38
side cover plate, description  39

vacuum pumps
forepump  40
turbomolecular pump  39

vacuum service switch
and mass spectrometer shutdown  50
location  48
mass spectrometer components on/off status  58

vacuum system
auxiliary gas valve  42
block diagram  37
checking pressure levels  62
collision gas valve  41
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